
 
 
 

User’s 
Manual 

IM 39J02B45-01E 

 
DTAP200 
DTSX200 Control Visualization 
Software Guide 

IM 39J02B45-01E 
2nd Edition 



 
 

Blank Page 
 



 < Introduction > i 
 

Introduction 

 About this Manual 
Thank you for purchasing the DTSX200 Control Visualization Software DTAP200. 
This document describes the functions, operation and usage precautions of the 
DTAP200. Read it carefully before using the software to ensure proper use. After 
reading, save this document in an accessible location for easy reference during 
software use.   
Besides this manual, the table below lists four other manuals related to the DTSX200 
Distribution Temperature Sensor. Read these manuals as well. 

Manual name Document No. Description 
DTSX200 Distributed 
Temperature Sensor 
Guide 

IM39J06B45-01E 
This document describes the functions, operation and 
usage precautions of the DTSX200 Distributed 
Temperature Sensor. 

DTSX200 
Communications 
(Modbus) Guide 

IM39J06B45-02E This manual describes commands for controlling the 
DTSX200 Distributed Temperature Sensor. 

DTAP200  
DTSX200 Control 
Visualization Software 
LAS 2.0 Data Conversion 
Guide 

IM39J02B45-02E 

This document describes the functions, operation and 
usage precautions of the software for converting and 
transmitting measurement data of the DTSX200 
Distributed Temperature Sensor in LAS format. 

DTAP200D 
DTSX200 Data 
Conversion Software 
WITSML1.3.1.1 Guide 

IM39J02B45-03E 
This document describes the functions, operation and 
usage precautions of the software for converting and 
transmitting measurement data of the DTSX200 
Distributed Temperature Sensor in WISTML format. 

 

 Caution 
• This document describes the DTSX200 Control Visualization Software R1.02.01. 

You can check your software version by selecting [Help] from the software menu 
bar. 

• YOKOGAWA reserves the right to make improvements in the manuals and product 
at any time, without notice or obligation. Moreover, actual screen display in the 
software may differ somewhat from the screen display contained in this document. 

• If you have any questions, or you find mistakes or omissions in the manuals, please 
contact our sales representative or your local distributor. 

• The use and operation of Windows is not described in this document. 
• No part of the manual may be transferred or reproduced without prior written 

consent from YOKOGAWA. 

 Trademarks and licensed software 
The following names are trademarks or registered trademarks of their respective 
holders. 
 
• DTSX200 is a trademark of Yokogawa Electric Corporation. 
• Microsoft and Windows are registered trademarks or trademarks of Microsoft 

Corporation in the United States and other countries. 
• Adobe and Acrobat are trademarks of Adobe systems Incorporated registered in 

certain regions. 
• Ethernet is a registered trademark of Xerox Corporation.
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• IBM and IBM-PC/AT are registered trademarks of IBM Corporation. 
• Other company and product names appearing in this document are trademarks or 

registered trademarks of their respective holders. 
• Registered trademarks and trademarks in this document are not displayed with TM 

or the ® mark. 
• The following third-party software are used in this software: 

NetAdvantage Icons © 2011 – Infragistics Products 

TeeChart Pro .NET v2010 
Copyright © 2010 by Steema Software SL 
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1. Before Using the Software  
 

1.1 Functional Description of the DTSX200 
Control Visualization Software 

 
DTAP200 includes two software applications, namely, DTSX200 Control Visualization 
Software and the DTSX200 Control Visualization Software LAS 2.0 Data Conversion. 
For information on how to use the DTSX200 Control Visualization Software, read this 
Guide. 

SEE ALSO 
For information on how to use DTSX200 Control Visualization Software LAS 2.0 Data Conversion, see 
the DTAP200 LAS 2.0 Guide (IM39J02B45-02E). 

 

HMI software 
Monitoring

Host data server

Data

HMI software
Monitoring

HMI software
Control and LAS data 

conversion

DCS

Protocols:
- SSH
- SCP(SFTP) Ethenet

HTTP 
protocol

Trace data

LAS data

 
 
The DTSX200 Control Visualization Software runs on a PC connected to a DTSX200 
via Ethernet. It has the four main functions described below. 
 

(1) Control mode 
In control mode, you can control temperature measurement by the DTSX200, acquire 
temperature data files created by the DTSX200 and display the data in charts. 
Acquired temperature data files are saved to a storage device connected to a PC. 
DTSX200 error and temperature alarm status display are also available. 

SEE ALSO 
For details, see Chapter 5, “Control Mode.” 

 

This software application 
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(2) Monitoring mode 
In monitoring mode, all functions of the control mode are available except DTSX200 
control functions. In monitoring mode, you can get temperature data files of a DTSX200 
module controlled by other DTSX200 Control Visualization Software and display the 
data in charts. 
As in control mode, acquired temperature data files are saved to a storage device 
connected to a PC. DTSX200 error and temperature alarm status display are also 
available. 

SEE ALSO 
For details, see Chapter 6, “Monitoring Mode.” 

 

(3) Calibration mode 
In calibration mode, you can use wizards to perform the following two types of 
calibration for the DTSX200: 
- detect fiber connection points automatically and enter fiber parameters for each 

connection point; 
- correct for fiber loss 

SEE ALSO 
For more details, see Chapter 7, “Calibration Mode.” 

 

(4) Trace mode 
In trace mode, you can load temperature data files, which are saved on a storage 
device connected to the PC and display the temperature data in a chart in offline state.  

SEE ALSO 
For more details, see Chapter 8, “Trace Mode.” 

 

 IMPORTANT 
 

- Up to eight instances of the DTAP200 (this software), DTAP200D and DTAP200 
LAS2.0 software applications combined can be run concurrently on a PC. 

- However, running multiple instances of the applications on a PC may slow down 
response time significantly due to heavy processing load so the use of a powerful 
PC is recommended. 

- Up to four users of the DTAP200 (this software), DTAP200D and DTAP200 LAS2.0 
software applications combined can be connected to the DTS concurrently. 
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- List of functions in each mode 

Function Control Mode Monitoring Mode Calibration Mode Trace 
Mode 

Online Offline Online Offline Online Offline Offline 
Setting 
measurement 
parameters 

Ο Δ Δ Δ Ο Δ X 

Measurement 
control Ο X X X Ο X X 

Saving 
measurement 
result 

Ο X Ο X Ο X X 

Measurement 
result display Ο Ο Ο Ο Ο Ο Ο 

Status display Ο Ο Ο Ο Ο Ο Ο 
Self-test execution Ο X X X Ο X X 

Ο: Enabled;  
Δ: Configurable but edited settings are not updated to DTSX200;  
X: Disabled 
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1.2 System Requirements 
● Operating system (OS) 

The software runs on the following operating systems: 
- Windows7 Home Premium SP1 (x86 / x64) 
- Windows7 Ultimate SP1 (x86 / x64) 
- Windows7 Professional SP1 (x86 / x64) 
- Windows7 Enterprise SP1 (x86 / x64) 

(.NET Framework 4.0 is required) 
 
The software is not guaranteed to run properly on other operating systems not listed 
above. 
 

● Personal computer (PC) 
The PC must be installed with any of the above operating systems, as well as a CPU 
and memory meeting the following requirements: 
Dual-core 32-bit processor 2 GHz or better 
2 GB or more memory 
 

● Hard disk 
2 GB or more free space 
 

● Optical disk drive 
An optical disk drive compatible with the operating system and capable of reading CD-
ROMs is required for software installation. 
 

● Mouse, keyboard and other input devices 
Input devices supported by the operating system 
 

● Display 
A video card recommended for use with the operating system and display device 
supporting 1024X768 dpi resolution or higher and 65536 colors or more, and supported 
by the operating system 
 

● Printer 
Printer and printer driver compatible with the operating system 
 

● Ethernet adaptor 
Ethernet adaptor (100BASE-TX or 10BASE-T) supported by the operating system 



 < 1. Before Using the Software > 5 
 

  IM 39J02B45-01E  
 

● Baud rate (throughput) 
Baud rate between PC and DTSX200: 500 kbps or higher 
Module operation may be unstable if baud rate (throughput) is below 500 kbps. 

TIP 
- To install the software in Windows7, you must log in as a user with Administrator authority. 

 

1.3 Installation Procedure 
SEE ALSO 
Read the DTAP200 installation manual (IM39J02B45-04E) bundled with the software. 

 
 

1.4 Network Setup 

 
 
Set the IP address of the PC to a fixed IP address on the same segment as the IP 
address of the DTSX200. 
As shown in the figure above, select the Use the following IP address option, and enter 
the IP address and subnet mask. For details on the network settings, consult your 
system administrator.   
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2. Using the Software 
 

2.1 Operation Flowchart 
The operation flowchart below shows the overall operation flow when using the software 
for the first time. For details on individual items, see the respective chapters or sections 
indicated in the flowchart. 
 

Install software

Installation Procedure (Section 1.3)
Install the software on the PC.

Run software

Startup Sequence (Section 3.1)
Running the Software (Section 3.2)
Selecting Operation Mode (Section 3.3)

Run the software.

Connect to DTSX200

Network Setup (Section 1.4)
Connecting to DTS (Section 3.4)

Connect the software to DTSX200.

Parameter Setup

Single-ended Measurement (Section 5.3)
Double-ended Measurement (Section 5.4)
Single & Continuous Sequence Measurement 
(Section 5.5) 
Temperature Alarm Display (Section 5.6)

Set DTSX200 measurement parameters.

Set temperature calibration parameters of 
DTSX200 using wizards.
Automatic Connection Point Detection (Section 7.2)
Temperature Calibration (Section 7.3)
Configure storage of DTSX200 
measurement data to PC.
Preparing for Measurement (Section 5.2)

Measurement

Starting and Stopping Measurement (Section 4.5)
Start and stop measurement.

Check measurement progress.

Status Display (Section 4.6)
Check measurement results.

Chart Display (Section 4.7)
Check for temperature alarms or DTSX200 
failure alarms.
Alarms (Section 4.9)

Terminate software execution

Terminating the Software (Section 3.6)
Terminate software execution.

Check result

Trace Mode (Chapter 8)
Chart Display (Section 4.7)

Check previously saved measurement 
result in trace mode. 
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3. Running and Terminating the 
Software 
 

3.1 Startup Sequence 
The flowchart below gives an overview of the startup sequence for the DTSX200 
Control Visualization Software. For details on individual items, see the respective 
sections. 

Begin startup sequence

End of startup sequence

Double-click 
executable (.exe) file.

Mode Select dialog 
is displayed.

Mode selection

Connect dialog
is displayed.

Open Trace dialog
is displayed.

Specify folder or file.

Trace mode selected

Control, Monitor or Calibration 
mode selected

Execution is terminated.
[Cancel]

Software is started 
in offline state.

　- Select row No.
　- Enter IP Address or Port.

[Select] or [Cancel]?

Select Switch dialog
is displayed.

Select number of channels 
from Ch1, Ch2, Ch4 or Ch16

[Cancel]

User ID / Password dialog
is displayed.

[Select]

Enter user ID and password.

[Connect] or [Cancel]?
[Cancel]

[Connect]

Software is started 
in online state.
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3.2 Running the Software 
This section describes how to run the DTSX200 Control Visualization Software. 

● Running the software from the Start menu 
In Microsoft Windows running on a PC, select Start>All Programs> YOKOGAWA 
DTSX200>DTSX200 Control Visualization Software. 

● Running the software from its desktop icon 
You can also run the software by double-clicking the “DTSX200 Control Visualization 
Software.exe” icon on the desktop. 

 
 

3.3 Selecting Operation Mode 
At startup, the DTSX200 Control Visualization Software first displays the Select Mode 
dialog for selecting the operation mode. 

● Selecting operation mode 
Select Control, Monitor, Calibration or Trace as the operation mode, and click [OK]. This 
confirms the operation mode selection. 
If you have selected Control, Monitor or Calibration mode, proceed to connect with 
DTSX200 (see Section 3.4). 
If you have selected Trace mode, proceed to specify a trace folder (or trace file)  
(see Chapter 8). 

SEE ALSO 
For details on individual operation modes, see Chapters 5 to 8. 

 

● Cancel 
Clicking [Cancel] aborts the execution of the DTSX200 Control Visualization Software. 

 

Confirm mode selection. 
Abort execution. 
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3.4 Connecting to DTSX200 
If you have selected the control, monitor or calibration operation mode, the DTSX200 
Control Visualization Software starts up in the selected operation mode and displays the 
Connect dialog. 
At this point, operations of the DTSX200 Control Visualization Software are still 
disabled. First, you need to define settings for connection to the DTSX200. 

 
 

 IMPORTANT 
 

- Only users with read and write authority are allowed to connect to the DTSX200. 
- We recommend using the latest version for the DTAP200 software, as well as the 

firmware on the DTSX200 to be connected, as there may be functional limitations 
otherwise. 
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● Define settings for connection to DTSX200 
1.  On the Connect dialog, select the row with network setting (IP address) and CV Soft 

setting (port number) matching the DTSX200 to be connected by clicking on its row 
header. An arrow (►) mark is displayed before the selected row. 

 

 
 
Example: DTSX200 system configuration 

 

Row header 

Selected row 

Select the DTSX200 to 
be connected. 



 <3.  Running and Terminating the Software > 13 
 

  IM 39J02B45-01E 
  

 
2.  If none of the displayed rows matches the IP address and the port number of the 

destination DTSX200, edit a cell value to the required value by first clicking on the 
cell to enable it.   

 

TIP 
- Cell numbers displayed in the [No.] column cannot be edited. Only values in the IP Address and 

Port columns can be edited. 

- The software performs input validation when you move the focus to another cell or another control 
after editing a cell value. If an invalid edited value is detected, the edited value reverts to its 
unedited value and an error provider control is displayed in the row header area. To see the error 
message, move the mouse cursor over the error provider. 

Editing a cell 

 
 
Displaying an error 

 
 
- IP address must be entered in IP address (IPv4) format. 

- Port number must be an integer from 0 to 65535. 

 

Cell being edited 

Invalid input 

Setting reverts to its 
unedited value. 

Error message 

Error provider 
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3.  Click [Select]. The UserID/Password dialog is displayed. 
4.  Enter the user ID and password of a user having read and write authority. 
 

 
 

Example: DTSX200 system configuration 

 

TIP 
- The [Connect] button is enabled when a user ID is entered. 

- Enter the user ID and password of a user account registered in the DTSX200. 

 

SEE ALSO 
For details on how to register a user account, see the DTSX200 Guide (IM39J06B45-01E). 

 

Begins connection 

Returns to  
Connect dialog. 
 

List of registered user accounts 
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5.  Clicking [Connect] initiates connection to DTSX200. Clicking [Cancel] returns to the 
Connect dialog. 

TIP 
- When you click [Connect] on the UserID/Password dialog, edited settings on the Connect dialog 

are saved and will be displayed in the Connect dialog when the software is next executed. Up to 
five IP address and port number pairs can be saved. Entered values are not saved if you click 
[Cancel]. 

- Values entered in the UserID/Password dialog are not saved and must be re-entered each time. 

 

● Canceling connection to DTSX200 
You can abort a connection by clicking the [Cancel] button in the Connect dialog or the 
[X] button at the top right corner of the Connect dialog. Doing so runs the software in 
offline state. 

 
 

Aborts 
connection 

Five IP address and 
port number pairs 
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3.5 Online and Offline States 
In online state when the software is connected to the DTSX200, you can monitor and 
control measurement by the DTSX200, as well as perform temperature calibration, etc. 
On the other hand, in offline state where the software is not connected to the DTSX200, 
you can redisplay previously acquired measurement data and recalculate temperature 
data (in trace mode), as well as edit and save settings. 
 

● Online state 
To control and monitor measurement by the DTSX200, as well as perform temperature 
calibration, run the software in online state. To do so, click [Connect] in the 
UserID/Password dialog. Connection to the DTSX200 begins and the DTSX200 Control 
Visualization Software is activated. The status display changes from “Idle” to 
“Connecting…” and when connection is successful, to “Connect (IP address of 
DTSX200).”   

 
 

Status display 
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TIP 
- If connection is unsuccessful, the status display changes to “Retry connection” and the software 

retries to connect until connection is successful. If the IP address, user ID or password is invalid or 
the number of attempts exceeds the maximum limit, however, the following error message dialog is 
displayed and the status display changes to “Idle.” 

 
 The [Connect] button of the main window is enabled at this time. Click [OK] on the error message 

dialog, and then click the [Connect] button to redisplay the Connect dialog. Re-enter a valid user ID 
and a password to connect to the DTSX200. 

 
- If connection is successful, the number of channels displayed under Channel Setting automatically 

changes to match the number of channels of the optical switch. 

- If connection is successful, the current setting values of the DTSX200 are retrieved and displayed 
under Sequence Setting and Channel Setting. 
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● Offline state 
Selecting Control, Monitor or Calibration operation mode but not connecting to 
DTSX200 runs the software in offline state where only editing of setting values is 
allowed. To run in offline state, click [Cancel] in the Connect dialog. Without connecting 
to the DTSX200, the number of channels for the optical switch cannot be determined 
automatically and thus must be specified manually. When Select Switch dialog is 
displayed, select either switchless , 2 channels, 4 channels or 16 channels for the 
Switch Type. 

 
Click [OK] on the Select Switch dialog window. The switch type (number of channels) is 
confirmed and the DTSX200 Control Visualization Software is activated. The status 
display, however, remains as “Idle.” 

 

Confirm the 
number of channels. 
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TIP 
- The number of channels displayed on Channel Setting changes automatically to match the number 

of channels selected for optical switch on the Select Switch dialog. 

- Sequence Setting and Channel Setting display the last confirmed edited settings. 

- If Trace operation mode is selected, the software always runs in offline state. The software startup 
sequence in Trace mode differs from the other operation modes. For details on Trace mode, see 
Chapter 8, “Trace Mode.” 

 
 

3.6 Terminating the Software 
This section describes how to terminate the execution of the DTSX200 Control 
Visualization Software. 
 

● Terminating the software from the main window menu 
1.  Click the icon at the top left of the main window. A menu is displayed. 
2.  Select [Exit] from the menu. 

 
 

● Terminating the software using the [X] button of the main window 
You can also terminate software execution by clicking the [X] button at the top right 
corner of the main window. 
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4. Basic Software Operations 
This chapter describes the windows, dialogs and basic operations of the 
software.  
This document distinguishes between “windows”, which can be docked to the 
main window or Chart window, and “dialogs”, which are displayed as pop-ups of 
windows. 
 

4.1 Window Components and Functions 
When the software is first executed, the main window, Solution Tree window, Chart 
window, Viewer_1 Chart window, Alarm window and Message window are displayed. 
For subsequent executions, windows that were previously displayed when software 
execution was last terminated are restored. Previously displayed Viewer_1-4 Chart 
windows, however, are not restored. Only the Viewer_1 Chart window is always 
displayed at software startup.   

TIP 
- Viewer_1-4 Chart windows are chart display windows displayed in the Chart window. 

 
 

 
 
 
 

Main window Solution Tree window 

Chart window 

Viewer_1 Chart window 

Alarm window Message window 
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4.1.1 List of Windows and Dialogs 
The tables below list the windows and dialog windows of the software. Dialogs for 
loading and saving are, however, omitted. 

Window 
Name Description For Details, See: 

Main Base window Subsection 4.1.2,  
Main Window 

Solution 
Tree Displays solution tree Subsection 4.1.3,   

Solution Tree window 

Chart Base window for displaying Viewer_1-4 Chart windows Section 4.7,  Chart Display 

Message Displays software messages Section 4.8, Messages 

Alarm Reports DTSX200 errors and warnings Section 4.9, Alarms 
Viewer_1-4 
Chart Displays measurement data in a chart Section 4.7, Chart Display 

 
Dialog name Description For details, see: 

Sequence setting Measurement sequence settings 

Chapter 5, Control Mode Channel_1-16 Channel settings 

Trace Storage Config Settings for trace data storage 

Viewer_1-4 Config Configures display of Viewer_1-4 Chart 
windows Section 4.7, Chart Display 

Fiber Connection 
Calibration Wizard Fiber connection calibration wizard Section 7.2, Automatic 

Connection Point Detection Fiber Connection 
Calibration Fiber connection calibration 

Fiber Parameter 
Calibration Wizard Fiber parameter calibration wizard Section 7.3,  

Temperature Calibration Fiber Parameter 
Calibration Fiber parameter calibration 

CSV Save Config Conversion to CSV file Section 8.3,   
Saving to CSV File 

Self Test DTSX200 self test execution Section 5.8, Self-test 
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4.1.2 Main Window 
The main window is the base window for all other windows, which can be dragged and 
dropped onto the main window. Viewer_1 to 4 Config windows, however, are based on 
the Chart window and thus cannot be dragged and dropped directly onto the main 
window. 

● Start Menu button 
The Start Menu button is displayed at the top left corner of the main window. Clicking 
the Start Menu button displays the Start menu for selection of the Open, Save and Exit 
operations.   

 
 

● Title bar 
The title bar is displayed at the top of the main window. The title bar displays the 
application name as “DTSX200 Control Visualization Software_n” where the suffix n is 
the application launch ID, which is assigned serially from 1 to 8 each time a DTSX200 
software application is run. Up to eight DTSX200 applications can run concurrently on 
one PC. 

 

TIP 
- Besides this software, other DTSX200 applications include the “DTSX200 Data Control 

Visualization Software LAS 2.0 Data Conversion” and the “DTSX200 Data Conversion Software 
WITSML 1.3.1.1”. 

 

● Menu 
A menu is displayed at the top of the main window. The menu displays a list of buttons 
for operating the application. You can switch between menus by clicking one of the 
three tabs displayed above the menu. 

Menu (Tab) Description 

Home Lists buttons for the main functions of the current mode, 
DTSX200 control functions and settings edit functions. 

View Lists buttons for displaying windows and dialogs. 

Tool Displays a button for displaying the Self Test dialog for DTSX200 
self-test execution. 
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The table below lists the group boxes and buttons for each tab. 

Menu item 
(Tab, group box or 

button) 
Description 

Home Tab for main functions of each mode, DTSX200 control functions and 
settings edit functions 

  

DTS Control Group box for DTSX200 control functions 

  
Connect Button for displaying the Connect dialog 
Start Button for starting measurement 
Stop Button for stopping measurement 

Wizard Group box for main functions of calibration mode 

  
Fiber Connection Button for running the Fiber Connection Calibration Wizard  
Fiber Parameter Button for running the Fiber Parameter Calibration Wizard 

Trace Group box for main functions of trace mode 

  Scaling Of Trace 
Database (*1) Group box for trace data selection functions 

Edit Group box for settings edit functions 

  
Copy (*2) Drop-down button that displays a menu for copying various settings  
Paste (*2) Drop-down button that displays a menu for pasting various settings  
Default (*2) Drop-down button that displays a menu for defaulting various settings   

View Tab for window and dialog display functions 

  

Setting Group box for DTSX200 settings 

  
Sequence setting Button for displaying Sequence Setting dialog 
Channel Setting (*3) Drop-down button that displays a menu for displaying Channel_1-16 dialogs 

Configuration Group box for application configuration 

  

CSV Save Config Button for displaying the CSV Save Config dialog 
Trace Storage 
Config Button for displaying the Trace Storage Config dialog 

Viewer Config (*4) Drop-down button that displays a menu for displaying Viewer_1-4 Config 
dialogs 

Windows Group box for window display and manipulation 

  

Solution Tree Button for displaying and giving focus to the Solution Tree window 

Viewer Chart (*5) Drop-down button that displays a menu for displaying and giving focus to 
the Chart window and each Viewer_1-4 Chart window 

Message Button for displaying and giving focus to the Message window 
Alarm Button for displaying and giving focus to the Alarm window 

Home tab 

View tab 

Tool tab 
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Default Layout Button for initializing the display positions of windows 
Tool Tab for temperature measurement test functions 

  
Self Test Group box for DTSX200 self-test function 
  Self Test Button for displaying the Self Test dialog 

*1: Scaling Of Trace Database group box contains buttons and scroll bars for selecting trace data. For details, see 
Chapter 8, "Trace Mode." 

*2: Clicking the Copy, Paste or Default drop-down button displays a menu of settings for selection. For details, see 
Section 4.3, "Copying, Pasting and Defaulting Settings." 

*3: Clicking the Channel Setting drop-down button displays a menu for displaying each Channel dialog. For details, see 
Chapter 5, "Control Mode." 

*4: Clicking the Viewer Config drop-down button displays a menu for displaying and giving focus to each Viewer Config 
window. For details, see Section 4.7, "Chart Display." 

*5: Clicking the Viewer Chart drop-down button displays a menu for displaying and giving focus to the Chart window 
and each Viewer Chart widow. For details, see Section 4.7, "Chart Display." 

 
The display of the tabs, group boxes and buttons varies with the operation mode 
(control, monitor, calibration or trace) and the online/offline state. The table below shows 
the display in each operation mode in online state and offline state. 

Tab, group box or 
button 

Online  Offline 

Control Monitor Calibrati
on Control Monitor Calibrati

on Trace 

Home Ο Ο Ο Ο Ο Ο Ο 

  

DTS Control 

Ο 
Ο 

Ο X X X X 
  

Connect 
Start 

X 
Stop 

Wizard 

X X Ο X X Δ X 
  

Fiber 
Connection 
Fiber Parameter 

Trace 
X X X X X X Ο 

  Scaling Of Trace 
Database 

Edit 

Ο Ο Ο Ο Ο Ο Ο 
  

Copy 
Paste 
Default 

View Ο Ο Ο Ο Ο Ο Ο 

  

Setting 

Ο Ο Ο Ο Ο Ο Ο 
  

Sequence 
setting 
Channel Setting 

Configuration Ο Ο Ο Ο Ο Ο Ο 

  

CSV Save 
Config X X X X X X Ο 

Trace Storage 
Config Ο Ο Ο Ο Ο Ο Ο 
Viewer Config 

Windows 

Ο Ο Ο Ο Ο Ο Ο 
  

Solution Tree 
Viewer Chart 
Message 
Alarm 
Default Layout 

Tool Ο X Ο X X X X 
Ο Displayed 
Δ Displayed but not selectable 
X Not displayed 
 
 
 
 



 <4.  Basic Software Operations  > 26 
 

  IM 39J02B45-01E 
  

 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 
 
 
 

Home tab in online monitoring mode 

Home tab in online calibration mode 

Home tab in offline control or monitoring mode 

Home tab in offline calibration mode 

Home tab in offline trace mode 

Home tab in online control mode 
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● Help button 
The Help button is displayed near the top right corner of the main window. Clicking the 
Help button displays the Information dialog window.  

SEE ALSO 
For details, see Section 4.10, “Help.” 

 

 

Help button 

View tab in offline (or online) control, monitor  
or calibration mode 

View tab in offline trace mode 

Tool tab in offline control or calibration mode 
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● Status bar 
The Status bar is displayed at the bottom of the main window. It displays the DTSX200 
connection status and measurement status.  

SEE ALSO 
For details, see Section 4.6, “Status Display.” 

 
 

 

● Other buttons 
The Minimize button, Maximize/Reduce button and the Close button are displayed at 
the top right corner of the main window. 
 

 
 
 
 

Status bar 

Maximize button 

Close button 

Minimize button 
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4.1.3 Solution Tree Window 
Selecting View>Windows>Solution Tree displays (or if already displayed, gives focus to) 
the Solution Tree window. The table below lists the functions of the Solution Tree 
window. 
The Solution Tree window can be used to display other windows and dialogs, to copy 
settings and perform other operations. 

 
 

 
 

● Solution Tree window layout 
The Solution Tree window displays nodes structured in the form of a tree. The current 
operation mode (Control, Monitor, Calibration or Trace) is displayed at the top as the 
root node and the tree of nodes is up to five levels deep.  

Click 

Displayed  
and given focus 
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Nodes displayed at the bottom level are called leaf nodes. Leaf nodes are bolded in the 
table below. Double-clicking on a leaf node displays its associated window or dialog. 
Right-clicking on some nodes displays a context menu of functions for loading settings, 
copying, etc. 
Details on window display, dialog display and context menu operations of the Solution 
Tree window are described later in this chapter.  
The table below shows the tree structure of the nodes. 

TIP 
- In online state, individual nodes for displaying dialogs may be enabled or disabled depending on 

the state of the DTSX200. Double-clicking on a disabled node will not display its associated dialog. 

 
Node Name Description 

Control, Monitor,  
Calibration or Trace Root node displaying the operation mode 

  

CSV Save Config Node for displaying the CSV Save Config dialog 
Wizard Group node for calibration related nodes 

  
Fiber Connection Node for running the Fiber Connection Calibration Wizard 
Fiber Parameter Node for running the Fiber Parameter Calibration Wizard 

Setting Group node for settings-related nodes 

  

User Setting Node for grouping and operating user settings related nodes. 

  
Sequence Setting Node for displaying and operating the Sequence Setting dialog 
Channel Setting Group node for channel related nodes 
  Channel_1-16 (*1) Nodes for displaying and operating Channel_1-16 dialogs 

Trace Storage Config Node for displaying and operating the Trace Storage Config dialog 

Trace Group node for nodes related to measurement data chart display 
and configuration. 

  

Viewer_1- 4 (*2) Group node for chart display and chart configuration for Viewer_1 
to  Viewer_4 windows. 

  
Chart Node for displaying and giving focus to Viewer_n Chart window (n 

matches the number of the parent node) along with Chart window. 

Config Node for displaying and operating Viewer_n Config dialog (n 
matches the number of the parent node.) 

Window Group node for window display related nodes 

  
Message Node for displaying and giving focus to the Message window 
Alarm Node for displaying and giving focus to the Alarm window 

Self Test Node for displaying the Self Test dialog 
*1: In online state, nodes are displayed for the number of channels installed in the DTSX200. 
 In offline state, nodes are displayed for the number of channels selected in the Select Switch dialog. 
*2: Only Viewer_1 is displayed in Calibration mode. 
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The display of the nodes varies with the operation mode (Control, Monitor, Calibration or 
Trace) and the online/offline state. The table below shows the display in each operation 
mode in online state and offline state. 

Node Name 
Online Offline 

Control Monitor Calibratio
n Control Monitor Calibratio

n Trace 

Control, Monitor,  
Calibration or Trace Control Monitor Calibration Control Monitor Calibration Trace 

  

CSV Save Config X X X X X X Ο 
Wizard 

X X Ο X X Δ X   Fiber Connection 
Fiber Parameter 

Setting 

Ο Ο Ο Ο Ο Ο Ο 

  

User Setting 

  
Sequence Setting 
Channel Setting 
  Channel_1-16 Ο(*1) Ο(*1) Ο(*1) Ο(*2) Ο(*2) Ο(*2) Ο(*2) 

Trace Storage Config Ο Ο Ο Ο Ο Ο Ο 
Trace 

Ο Ο 

Ο 

Ο Ο 

Ο 

Ο   
Viewer_1 to 4 

Ο(*3) Ο(*3)   Chart 
Config 

Window 
Ο Ο Ο Ο Ο Ο Ο   Message 

Alarm 
Self Test Ο X Ο X X X X 

Ο Displayed 
Δ Displayed but not selectable 
X Not displayed 
*1: Nodes are displayed for the number of channels installed in the DTSX200.  
*2: Nodes are displayed for the number of channels selected in the Select Switch dialog.  
*3: Only Viewer_1 is displayed. 
 
 
 

    
 
 
 
 
 

Control mode  
(online) 

Monitoring mode 

Not displayed 
in offline state 
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Calibration mode 
(online) 

Calibration mode 
(offline) 
 

Trace mode 
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Number of channels=1    Number of channels=2    Number of channels=4    Number of 
channels=16 

 

● Context menus 
In the Solution Tree window, right-clicking on a node bolded in the table below displays 
its associated context menu.  
The table below shows the mapping between context menus and nodes. 

Node Name Control Monitor Calibration Trace 
Control, Monitor,  
Calibration or Trace I(*1) II(*1) I(*1) X 

  

CSV Save Config       X 
Wizard 

    X   
  

Fiber Connection 
Fiber Parameter 

Setting X X X X 

  

User Setting III IV III IV 

  
Sequence Setting III IV III IV 
Channel Setting X X X X 
  Channel_1-16 (*3) V IV V VI 

Trace Storage Config III III III IV 
Trace X X X X 

  
Viewer_1 to 4  (*4) X X X X 

  
Chart X X X X 
Config V V V V 

Window X X X X 

  
Message X X X X 
Alarm X X X X 

Self Test X (*2)   X (*2)   
*1:  Context menu is displayed only in online state. 
*2:  Node is displayed only in online state. 
*3:  In online state, nodes are displayed for the number of channels installed in the DTSX200. In offline state, nodes are 

displayed for the number of channels selected in the Select Switch dialog. 
*4:  Only Viewer_1 is displayed in Calibration mode. 
/ Node is not displayed. 
X Node has no context menu. 
I to VI: context menu  
(see text on the right for details) 
I Connect/Start/Stop 
II Connect 
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III Open/Save/Default 
IV Save 
V Open/Save/Copy/Paste/Default 
VI Save/Copy/Paste 
 

Operation Type Item Description 

DTSX200 
operations 

Connect Displays dialog for connection to DTSX200. 

Start Starts measurement. 

Stop Stops measurement. 

Settings operations 

Open Loads settings file for the node. 

Save Saves settings file for the node. 

Copy Copies settings for the node. 

Paste Pastes settings for the node. 

Default Initializes settings for the node. 

 

      
Context menu for DTSX200 control                Context menu for settings manipulation 

TIP 
- In online state, individual nodes with context menus may be enabled or disabled depending on the 

state of the DTSX200. Right-clicking on a disabled node will not display its associated context 
menu. 

- In online state, individual menu items on a displayed context menu may be enabled or disabled 
depending on the state of the DTSX200. A disabled context menu item cannot be selected. 

- Operations on the context menu of the User Setting node apply to the combined settings of the 
Sequence Setting and Channel Setting nodes just below it. 
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4.2 Loading and Saving Settings 
Settings specified using the software can be saved to or loaded from a settings file 
either from the Start menu of the main window or from a context menu in the Solution 
Tree window. 
 

4.2.1 Loading and Saving Settings from the Start Menu 
This subsection describes how to load and save settings from the Start menu of the 
main window by selecting Start menu>Open and Start menu>Save respectively. 

 
Clicking Open or Save on the Start menu displays a cascade menu of settings type. 
Selecting a settings type to be loaded or saved from the displayed menu displays a 
corresponding open/save dialog.  
The table below lists each Open or Save menu option along with the open/save dialog 
displayed and the settings file loaded or saved when the option is selected from the 
menu. 

Open menu  
or Save menu 

Open/Save Dialog Displayed, 
Settings File Type 

File 
Extension 

User Setting 
"Open/Save a user setting file" dialog 
Settings file combining Sequence Setting and settings for 
Channel_1 to 16 

*.dua 

Sequence Setting "Open/Save a sequence setting file" dialog 
Sequence settings file *.dus 

Channel Setting (*1) 

  Channel_1 to 16 (*2) 
"Open/Save a channel setting file" dialog 
Channel settings file (separate operation for Channel_1 to 
16) 

*.duc 

Viewer Config (*3) 

  Viewer_1 to 4 (*4) 
"Open/Save a viewer configuration file" dialog 
Setting files for charts 1 to 4 (separate operation for 
Viewer_1 to 4) 

*.dug 

Trace Storage Config "Open/Save a trace storage configuration file" dialog 
Trace storage configuration file *.dur 

*1: Displays menu options for Channel_1 to 16. 
*2: In online state, menu options are listed for the number of channels installed in the DTSX200. 
 In offline state, menu options are listed for the number of channels selected in the Select Switch dialog. 
*3: Displays menu options for Viewer_1 to 4. 
*4: Only Viewer_1 is displayed in Calibration mode. 

TIP 
- The User Setting menu option combines Sequence Setting and Channel Setting (settings for 

Channel_1 to Channel_16). It can be used for loading or saving sequence settings and all channel 
settings for a DTSX200 in one go. If the DTSX200 is installed with less than the maximum of 16 
channels, settings for uninstalled channels are disabled. 

 
The menu displayed when Start>Open is selected varies with the operation mode. 
Moreover, some menu items are disabled during measurement and disconnection in 
online state. The table below shows these dependencies.   
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Open menu Control Monitor Calibration Trace 
User Setting Ο(*1) X Ο(*1) X 
Sequence Setting Ο(*1) X Ο(*1) X 
Channel Setting Ο(*1) X Ο(*1) X   Channel_1-16 (*2) 
Viewer Config Ο Ο Ο Ο   Viewer_1-4 (*3) 
Trace Storage Config Ο(*1) Ο(*1) Ο(*1) X 

Ο Displayed. 
X Not displayed. 
*1: Disabled during measurement or disconnection in online state.  
*2: In online state, menu options are listed for the number of channels installed in the DTSX200. 
 In offline state, menu options are listed for the number of channels selected in the Select Switch dialog. 
*3: Only Viewer_1 is displayed in Calibration mode. 
 

    
Open menu in control or calibration mode               Open menu in monitoring mode 

 
Open menu in trace mode 

● Procedure for loading settings (in main window) 
We describe the procedure below using an example for loading channel settings of 
Channel 1. 
 
1.  Select Start menu>Open>Channel Setting>Channel_1. (The “Open a channel 

setting file” dialog is displayed.) 

 
2.  Specify the folder containing the channel settings file to be loaded. 
3.  Select the channel settings file to be loaded and click [Open]. (The “Open a channel 

setting file” dialog closes.) 
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After loading is completed, you can check the loaded channel settings by selecting 
View> Setting>Channel Setting>Channel_1 to display the Channel_1 dialog window. 

TIP 
- In Windows 7, the following folder is specified by default in each Open dialog: 

 C:\Users\ <user name>\Documents\DTSX200 Control Visualization Software\SETUP 

 

1. Specify a folder. 

2. Select a file. 

3. Open the file. 
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● Procedure for saving settings (in main window) 
We describe the procedure below using an example for saving channel settings of 
Channel 1. 
1.  Select Start menu>Save>Channel Setting>Channel_1. (The “Save a channel 

setting file” dialog is displayed.) 

 
2.  Specify the destination folder for saving the channel settings file. 
3.  Specify a file name for saving the channel settings and click [Save]. (The “Save a 

channel setting file” dialog closes.) 
 
 

 

TIP 
- In Windows 7, the following destination folder is specified by default in each Save dialog window: 

 C:\Users\<user name>\Documents\DTSX200 Control Visualization Software\SETUP 

 

1. Specify a folder. 

2. Specify a file name. 

3. Save the file. 
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4.2.2 Loading and Saving Settings from Context Menu 
This subsection describes how to load and save settings from a context menu in the 
Solution Tree window by right-clicking on a node and selecting Open and Save 
respectively from the displayed context menu. 
Whether both Open and Save or only Save is displayed in the context menu of a node 
depends on the operation mode. Moreover, Open is disabled during measurement and 
disconnection in online state for some nodes. The table below shows these 
dependencies. 

Node 
Display of Open and Save in Context Menus in Each Mode 

Control Monitor Calibration Trace 

User Setting Open (*1)/Save Save Open (*1)/Save Save 

  
Sequence Setting Open (*1)/Save Save Open (*1)/Save Save 
Channel Setting 
  Channel_1-16 (*2) Open (*1)/Save Save Open (*1)/Save Save 

Trace Storage Config Open (*1)/Save Open 
(*1)/Save Open (*1)/Save Save 

Viewer_1 to 4 (*3) 
  Config Open/Save Open/Save Open/Save Open/Save 

*1: Disabled during measurement or disconnection in online state.  
*2: In online state, nodes are displayed for the number of channels installed in the DTSX200. In offline state, nodes are 

displayed for the number of channels selected in the Select Switch dialog. 
*3: Only Viewer_1 is displayed in Calibration mode. 
 
 

      
(in control or calibration mode)    (in monitor or trace mode) 

TIP 
- The context menu of the User Setting node combines Sequence Setting and Channel Setting 

(settings for Channel_1 to Channel_16). It can be used for loading or saving sequence settings 
and all channel settings for a DTSX200 in one go. If the DTSX200 is installed with less than the 
maximum of 16 channels, settings for uninstalled channels are disabled. 

 
 

Context menu for User Setting 
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The table below shows the open or save dialog displayed and the settings file loaded or 
saved when Open or Save is selected from the context menu of each node. 

Node Open/Save Dialog Displayed, 
Settings File Type File Extension 

User Setting 
"Open/Save a user setting file" dialog 
Settings file combining Sequence Setting and 
settings for Channel_1 to 16 

*.dua 

  

Sequence Setting "Open/Save a sequence setting file" dialog 
Sequence settings file *.dus 

Channel Setting 

  Channel_1-16 (*1) 
"Open/Save a channel setting file" dialog 
Channel settings file (separate operation for 
Channel_1 to 16) 

*.duc 

Trace Storage Config 
"Open/Save a trace storage configuration 
file" dialog 
Trace storage configuration file 

*.dur 

Viewer_1- 4 (*2) 

  Config 
"Open/Save a viewer configuration file" 
dialog window 
Setting files for charts 1 to 4 (separate 
operation for Viewer_1 to 4) 

*.dug 

*1: In online state, nodes are displayed for the number of channels installed in the DTSX200. 
 In offline state, nodes are displayed for the number of channels selected in the Select Switch dialog. 
*2: Only Viewer_1 is displayed in Calibration mode. 

● Procedure for loading settings (in Solution Tree window) 
We describe the procedure below using an example for loading channel settings of 
Channel 1. 
1.  Right-click the Channel_1 node. 
2.  Select Open from the context menu. (The “Open a channel setting file” dialog is 

displayed.) 

 
 
3.  Specify the folder containing the channel settings file to be loaded. 
4.  Select the channel settings file to be loaded and click [Open]. (The “Open a 

channel setting file” dialog closes.) 
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After loading is completed, you can check the loaded settings by double-clicking the 
Channel_1 node to display the Channel_1 dialog window. 

TIP 
- In Windows 7, the following folder is specified by default in each Open dialog: 

 C:\Users\<user name>\Documents\DTSX200 Control Visualization Software\SETUP 

 

● Procedure for saving settings (in Solution Tree window) 
We describe the procedure below using an example for saving channel settings of 
Channel 1. 
 
1.  Right-click on the Channel_1 node. 

 
 

1. Specify a folder. 
 

2. Select a file. 
 

3. Open the file. 
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2.  Select Save from the context menu. (The “Save a channel setting file” dialog is 
displayed.) 

3.  Specify the destination folder for saving the channel settings file. 
4.  Specify a file name for saving the channel settings and click [Save]. (The “Save a 

channel setting file” dialog closes.) 
 
 

 
 
 

1. Specify a folder. 
 

2. Specify a file name. 
 

3. Save the file. 
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4.3 Copying, Pasting and Defaulting Settings 
You can copy, paste and initialize (set to default values) settings either from the menu of 
the main window or from a context menu in the Solution Tree window. 

TIP 
- You must perform a copy operation before a paste operation. 

- A copy operation overwrites previously copied values. 

- Settings for one channel or settings for one chart are copied for each copy operation. A copy 
operation overwrites previously copied values. 

 

4.3.1 Copying, Pasting and Defaulting Settings from the Main 
Window Menu 
This subsection describes how to copy, paste and initialize (default) settings using the 
main window menu by selecting Home>Edit>Copy, Home>Edit>Paste and 
Home>Edit>Default respectively. 

 
 
Clicking Copy, Paste or Default on the menu displays a cascade menu for selecting the 
type of settings to be copied, pasted or defaulted. 
 
The table below shows the menu displayed when Copy or Paste is clicked on the main 
window menu. 

Copy Menu or Paste Menu Settings Type 
Channel Setting (*1) 
  Channel_1-16 (*2) Channel settings 
Viewer Config (*3) 
  Viewer_1- 4 (*4) Chart settings 

*1: Displays menu options for Channel_1 to 16. 
*2: In online state, menu options are listed for the number of channels installed in the DTSX200. 
 In offline state, menu options are listed for the number of channels selected in the Select Switch dialog. 
*3: Displays menu options for Viewer_1 to 4. 
*4: Only Viewer_1 is displayed in Calibration mode. 
 
The menu displayed when Copy and Paste is clicked on the main window menu varies 
with the operation mode. Moreover, some menu items are disabled during 
measurement and disconnection in online state. The table below shows these 
dependencies. 

Copy Menu or Paste Menu Control Monitor Calibration Trace 

Channel Setting  Ο(*1) X Ο(*1) Ο   Channel_1-16 (*2) 
Viewer Config  Ο Ο Ο Ο   Viewer_1- 4 (*3) 
Ο Displayed. 
X Not displayed. 
*1: Disabled during measurement or disconnection in online state.  
*2: In online state, menu options are listed for the number of channels installed in the DTSX200. 
 In offline state, menu options are listed for the number of channels selected in the Select Switch dialog. 
*3: Only Viewer_1 is displayed in Calibration mode. 
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Copy menu in control or calibration or trace mode 

(Paste menu is similar) 

 
Copy menu in monitor 

(Paste menu is similar) 

 
The table below shows the menu displayed when Default is clicked on the main window 
menu. 

Default Menu Settings Type 
User Setting Combination of Sequence Setting and settings for Channel_1 to 16 
Sequence Setting Sequence settings 
Channel Setting (*1) 
  Channel_1-16 (*2) Channel settings 
Viewer Config (*3) 
  Viewer_1-4 (*4) Settings for charts 1 to 4 
Trace Storage Config Trace storage configuration 

*1: Displays menu options for Channel_1 to 16. 
*2: In online state, menu options are listed for the number of channels installed in the DTSX200. 
 In offline state, menu options are listed for the number of channels selected in the Select Switch dialog. 
*3: Displays menu options for Viewer_1 to 4. 
*4: Only Viewer_1 is displayed in Calibration mode. 

TIP 
- The User Setting menu option combines Sequence Setting and Channel Setting (settings for 

Channel_1 to Channel_16). It can be used for defaulting (initializing) settings and all channel 
settings for a DTSX200 in one go. 

 
The menu displayed when Default is selected from the main window menu varies with 
the operation mode. Moreover, some menu items are disabled during measurement and 
disconnection in online state. The table below shows these dependencies. 

Default Menu Control Monitor Calibration Trace 
User Setting Ο(*1) X Ο(*1) X 
Sequence Setting Ο(*1) X Ο(*1) X 
Channel Setting Ο(*1) X Ο(*1) X   Channel_1-16 (*2) 
Viewer Config Ο Ο Ο Ο   Viewer_1-4 (*3) 
Trace Storage Config Ο(*1) Ο(*1) Ο(*1) X 

Ο Displayed. 
X Not displayed. 
*1: Disabled during measurement or disconnection in online state.  
*2: In online state, menu options are listed for the number of channels installed in the DTSX200. 
 In offline state, menu options are listed for the number of channels selected in the Select Switch dialog. 
*3: Only Viewer_1 is displayed in Calibration mode. 
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Default menu in Control or Calibration mode Default menu in Monitoring mode 

 
Default menu in Trace mode 

 

● Procedure for copying settings (in main window) 
We describe the procedure below using an example for copying channel settings of 
Channel 1. 
 
1.  Select Home>Copy>Channel Setting>Channel_1. 
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● Procedure for pasting settings (in main window) 
We describe the procedure below using an example for pasting to channel settings of 
Channel 2. 
 
1.  Select Home>Paste>Channel Setting>Channel_2. 

 
After pasting is completed, you can check the pasted channel settings by selecting 
View> Setting>Channel Setting>Channel_2 to display the Channel_1 dialog window. 

● Procedure for defaulting settings (in main window) 
We describe the procedure below using an example for defaulting channel settings of 
Channel 1. 
 
1.  Select Home>Default>Channel Setting>Channel_1. 

 
After defaulting is completed, you can check the initialized channel settings by selecting 
View> Setting>Channel Setting>Channel_1 to display the Channel_1 dialog window. 
 



 <4.  Basic Software Operations  > 47 
 

  IM 39J02B45-01E 
  

4.3.2 Copying, Pasting and Defaulting Settings from Context 
Menu 
This subsection describes how to copy, paste and default settings from a context menu 
in the Solution Tree window by right-clicking on a node and selecting Copy, Paste and 
Default respectively from the displayed context menu. 
 
Whether Copy, Paste and/or Default are displayed in the context menu of a node 
depends on the operation mode. Moreover, Paste and Default are disabled during 
measurement and disconnection in online state for some nodes. The table below shows 
these dependencies. 

Node 
Display of Copy, Paste and Default in Context Menus in Each Mode 

Control Monitor Calibration Trace 

User Setting Default (*1) X Default (*1) X 

  

Sequence Setting Default (*1) X Default (*1) X 

Channel Setting 

  Channel_1-16 (*3) Copy/Paste (*1)/ 
Default (*1) X Copy/Paste (*1)/ 

Default (*1) 
Copy/Paste 
(*2) 

Trace Storage Config Default (*1) Default (*1) Default (*1) X 

Viewer_1- 4 (*4) 

  Config Copy/Paste/ 
Default 

Copy/Paste/ 
Default 

Copy/Paste/ 
Default 

Copy/Paste/ 
Default 

*1: Disabled during measurement or disconnection in online state.  
*2: Only calculation parameters will be pasted. 
 For details, see Chapter 5, "Control Mode." 
*3: In online state, nodes are displayed for the no. of channels installed in the DTSX200. 
 In offline state, nodes are displayed for the no. of channels selected in the Select Switch dialog. 
*4: Only Viewer_1 is displayed in Calibration mode. 
 

TIP 
- The context menu of User Setting combines Sequence Setting and Channel Setting (settings for 

Channel_1 to Channel_16). It can be used for defaulting sequence settings and all channel 
settings for a DTSX200 in one go. 

 

● Procedure for copying settings (in Solution Tree window) 
We describe the procedure below using an example for copying channel settings of 
Channel 1. 
 
1.  Right-click the Channel_1 node. 
2.  Select Copy from the context menu. 
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● Procedure for pasting settings (in Solution Tree window) 
We describe the procedure below using an example for pasting to channel settings of 
Channel 1. 
1.  Right-click on the Channel_1 node. 
2.  Select Paste from the context menu. 

 
 
After pasting is completed, you can check the pasted channel settings by double-
clicking on the Channel_1 node to display the Channel_1 dialog window. 

● Procedure for defaulting settings (in Solution Tree window) 
We describe the procedure below using an example for defaulting channel settings of 
Channel 1. 
 
1.  Right-click on the Channel_1 node. 
2.  Select Default from the context menu. 

 
 
After defaulting is completed, you can check the initialized channel settings by double-
clicking on the Channel_1 node to display the Channel_1 dialog window. 
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4.4 Displaying Windows and Dialogs 
This section describes how to display windows and dialogs, as well as basic window 
operations. Windows and dialogs can be displayed from the menu of the main window 
or from a node in the Solution Tree window.   
A window or dialog can be displayed by clicking on its associated menu button in the 
main window. If the window is already displayed, it is given focus.  
A window or dialog can also be displayed by double-clicking on its associated node in 
the Solution Tree window. If the window is already displayed, it is given focus. 
 

4.4.1 Menu Items for Displaying Windows (in main window) 
This subsection describes the displaying of windows from the main window menu. The 
table below lists the menu items (tabs, group boxes, buttons and menus) for displaying 
windows. 

Menu Element 
(Tab, group box, button or menu) Description 

View (tab) 

  

Windows  (group box) 

  

Solution Tree (button) Displays and moves focus to Solution Tree 
window 

Viewer Chart (Drop-down button) 

  Viewer_1-4 Chart (*1) (menu) Displays and moves focus to Viewer_1-4 
Chart window and Chart window.  

Message (button) Displays and moves focus to Message 
window 

Alarm (button) Displays and moves focus to Alarm window 
*1: Only Viewer_1 is displayed in Calibration mode. 
 

 
 

4.4.2 Nodes for Displaying Windows (in Solution Tree 
Window) 
This subsection describes the displaying of windows from a node in the Solution Tree 
window. The table below lists the nodes for displaying windows. 

Node for Displaying 
Windows Description 

Control, Monitor, Calibration or Trace 

  

Trace 

  
Viewer_1-4 (*1) 

  Chart Displays and moves focus to Viewer_n Chart window along with 
Chart window (n matches the parent node).  

Window 

  Message Displays and moves focus to Message window 
Alarm Displays and moves focus to Alarm window 

*1: Only Viewer_1 is displayed in calibration mode. 
 



 <4.  Basic Software Operations  > 50 
 

  IM 39J02B45-01E 
  

 
 

4.4.3 Window Operations 
This subsection describes basic window operations. 

● Displaying and giving focus to a window 
A window can be displayed by clicking on its associated menu item in the main window 
or double-clicking on its associated node in the Solution Tree window. If the window is 
already displayed, it is given focus. 

TIP 
- Displaying a Viewer_1-4 Chart window automatically displays the Chart window. This applies 

similarly when giving focus to the window. 
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Click 

Double-click 

Displayed and given 
given focus 
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● Closing a window 
Clicking on the [x] button at the top right corner of a window closes it. 

TIP 
- Closing a Chart window automatically closes displayed Viewer_1-4 Chart windows. 

- Redisplaying a Viewer_1-4 Chart window after closing a Chart window automatically displays 
previously displayed Viewer_1-4 Chart windows. 

 

 

 
 

Click 

Both Chart window and Viewer_1 
Chart window are closed 
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● Auto-hiding a window 
Clicking on the [ ] button at the top right corner of a window auto-hides it. An auto-
hiding window appears as a tab along one of the four edges of the main window. An 
auto-hiding Viewer_1-4 Chart window, however, appears as a tab along one of the four 
edges of the Chart window. 

 

 
 

Click 

Window auto-
hides as a tab. 
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● Displaying an auto-hiding window temporarily 
Hovering the mouse pointer over the tab of an auto-hiding window displays the window 
temporarily. Moving the mouse pointer outside the temporarily displayed window auto-
hides it again.   
Clicking on a temporarily displayed window gives it focus. The window remains 
displayed until the focus is moved elsewhere. 

TIP 
- Hovering the mouse pointer over the tab of an auto-hiding window when the application itself is not 

in focus will not display the window temporarily. 

 

 

 
 

● Turning off auto-hiding of a window 
There are three ways to turn off auto-hiding of a window: 
Method 1: Clicking on [  ] when the auto-hiding window is temporarily displayed. 
Method 2: Clicking on its associated menu button in the main window. 
Method 3: Double-clicking on its associated node in the Solution Tree window. 

TIP 
- Auto-hiding of a Chart window can only be cancelled using method 1. Applying method 2 or 3 on a 

Viewer_1-4 Chart window temporarily displays and gives focus to the Chart window. (The Chart 
window remains displayed until the focus is moved elsewhere.) 

 

Hover mouse pointer over tab 

Auto-hiding window is 
displayed temporarily. 
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Click (method 1) 
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Click (method 2) 

Double-click (method 3) 

Displayed permanently 
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● Floating a window 
There are two ways to float a window as described below: 
Method 1: Double-click on the title bar of a window to be floated. 
Method 2: Drag and drop the title bar of a window to be floated (see procedure below): 
 
1.  Drag the title bar of a window to be floated. (Docking icons appear when the title 

bar is dragged over the display area of another window.) 
2.  Drop the title bar where the mouse pointer is not over a docking icon. 

 
 

Drag 

 
D

ouble-click 

Double-click 
(method 1) 

Drag (method 2) 

Drop where the mouse pointer  
is not over a docking icon. 
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● Returning a floating window to its previously docked position 
To return a floating window to its previously docked position, double-click its title bar. 
 

 
 

Window is floated 
 

Double-click 
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● Docking a window to any edge of the main window 
A window can be docked to any one of the four edges of a window other than the main 
window using the following procedure: 
 
1.  Drag the title bar of the window to be docked. (Docking icons appear when the title 

bar is dragged over the display area of another window.) 
2.  Drag, move the mouse pointer over the desired docking icon displayed on an outer 

edge, and drop. (An outline of the window (docking image) appears when the 
mouse pointer is over a docking icon.) 

TIP 
- A Viewer_1-4 Chart window can be docked within a Chart window. 

- If a window to be docked is the only displayed window, dropping it over any docking icon (except 
the cross center of the inner docking icons) will dock the window fully within the main window. 

 

Window returns to previously 
docked position 
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● Docking a window to any edge of a window other than the main window 
A window can be docked to any one of the four edges of a window other than the main 
window using the following procedure: 
1.  Drag the title bar of the window to be docked. (Docking icons appear when the title 

bar is dragged over another window.) 
2.  Drag the title bar over the display area of the window where you want to dock it. 

Move the mouse pointer over the desired docking icon (except the cross center) 
displayed on an inner edge, and drop the title bar. (An outline of the window 
(docking image) appears when the mouse pointer is over a docking icon.) 

Window is docked to 
desired position. 

Docking image 

Drag the mouse pointer  
over docking icon and drop. 
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TIP 
- A Viewer_1-4 Chart window can be docked to another Viewer_1-4 Chart window. 

- A window can also be docked to a floating window. When a window to be docked is dragged over 
the display area of a floating window, only the docking icons arranged as a cross appear. 

 

 
 

 
 

Drag the mouse pointer  
over docking icon and drop. 
 

Window is docked 
to desired position 

Docking image 
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● Tab-docking a window (creating a set of tabbed windows) 
A window can be tab-docked to another window, other than the main window. There are 
two ways to do this. 
Method 1: Using the docking icon (See detailed procedure below.) 
1.  Drag the title bar of the window to be tab-docked. (Docking icons appear when the 

title bar is dragged over the display area of another window.) 
2.  Drag the title bar over the display area of the window where you want to dock it. 

Move the mouse pointer over the cross center of the inner docking icons, and 
release the mouse button. (An outline of the window (docking image) appears when 
the mouse pointer is over a docking icon.) 

Method 2: Drag and drop window title bar onto the title bar of the destination window  
(See detailed procedure below.) 
1.  Drag the window title of the window to be tab-docked. 
2.  Move the mouse pointer over the title bar of another window and release the mouse 

button. (An outline of the window (docking image) appears when the mouse pointer 
is over the title bar.) 

TIP 
- A Viewer_1-4 Chart window can be tab-docked to another Viewer_1-4 Chart window. 

- If no other window is displayed, moving the mouse pointer over the cross center of the inner 
docking icons floats the window. 

 

 
 Drag the title bar over 

docking icon and drop it. 

Docking image  
(of tabbed window) 
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● Switching display between tabbed windows 
Clicking a tab at the bottom of a tabbed group switches the window display to the 
selected tabbed window. 

 
 

● Separating a tabbed window 
A superimposed window can be separated using any of the following two methods: 
Method 1: Double-click the tab of the window to be separated. (The separated window 

becomes a floating window.) 

Window tab-docked  
at desired position 

Click on a tab to switch 
between tabbed windows 
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Method 2: Drag and drop the tab of the window to be separated. (Dragging a tab has 
the same effect of dragging the title bar of that window.) 

TIP 
- In method 2, the dragged window can be floated or docked in any preferred way as follows: 

  Float the window (method 2) 

  Drag the tab to any one of the four edges of the main window 

  Drag the tab to any one of the four edges of another window 

 

 
 

Drag 

Title bar is dragged. 

 
D

ouble-click 

Double-click 
(method 1) 

Drag (method 2) 
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● Closing a tabbed window 
Clicking the [X] button at the top right corner of a tabbed window closes superimposed 
windows. 

TIP 
- If the tabbed window is docked in a main window, only the displayed window is closed. 

- If the tabbed window is floating, all windows of the tabbed group are closed. 

 

SEE ALSO 
For details on the window operation, see the description entitled “Closing a window.” 

 

● Auto-hiding tabbed windows 
Clicking on the [ ] button at the top right corner of the displayed window auto-hides its 
tabbed windows. Auto-hiding tabbed windows appear as a tab along one of the four 
edges of the main window. Viewer_1-4 Chart windows, however, are displayed as a tab 
along one of the four edges of the Chart window. 
Auto-hiding tabbed windows are grouped into a single tab, which displays their window 
titles jointly. The title of the tabbed window that is displayed before auto-hiding appears 
in full form in the tab while the titles of the other tabbed windows appear abbreviated in 
the tab. 

Floating window 
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● Displaying an auto-hiding tabbed window temporarily 
Hovering the mouse pointer over any window title in a tag displays the auto-hiding 
window temporarily. Moving the mouse pointer outside the temporarily displayed 
window auto-hides it again.   
When any auto-hiding window is displayed temporarily, its window title appears in full 
form in the tab while the titles of the other windows appear truncated. 
No tab is displayed at the bottom of the temporarily displayed window. (Switching 
display between windows is not allowed.)  

Auto-hiding tabbed windows 
are grouped into one tab. 

Click 
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Clicking on a temporarily displayed window gives it focus. The window remains 
displayed until the focus is moved elsewhere. 

TIP 
- Hovering the mouse pointer over a window title in a tab when the application itself is not in focus 

will not display the auto-hiding window temporarily. 

 

 
 

 
 

Hover the mouse pointer 
over the title of the window 
to be displayed. 
 

Window is  
displayed temporarily. 
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● Turning off auto-hiding of a tabbed window 
The method is similar to that for a normal non-tabbed window. For details, see the 
description entitled “● Turning off auto-hiding of a window.” 

● Floating a tabbed window 
The method is similar to that for a normal non-tabbed window. For details, see the 
description entitled “● Floating a window.” 

● Returning a floating tabbed window to its previously docked position 
The method is similar to that for a normal non-tabbed window. For details, see the 
description entitled “● Returning a floating window to its previously docked position.” 

● Docking a tabbed window to any edge of the main window 
The method is similar to that for a normal non-tabbed window. For details, see the 
description entitled “● Docking a window to any edge of the main window.” 

● Docking a tabbed window to any edge of a window other than the main 
window 
The method is similar to that for a normal non-tabbed window. For details, see the 
description entitled “● Docking a window to any edge of a window other than the main 
window.” 

● Resizing a window 
When multiple windows are displayed, the windows can be resized by dragging and 
dropping the boundary between the windows. A vertical boundary can be dragged left 
and right while a horizontal boundary can be dragged up and down.   
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Drag a vertical 
boundary left or right. 
 

Windows are resized. 
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Drag a horizontal 
boundary up or down. 
 

Windows are resized. 
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● Resizing a floating window 
A floating window can be resized by dragging and dropping one of its edges. The left 
and right edges of a floating window can be dragged left and right while the top and 
bottom edges of a floating window can be dragged up and down. The corners of a 
floating window can be dragged diagonally. 
 

 

 
 
 

 
 

● Initializing window layout 
Selecting View>Windows>Default Layout in the main window initializes the window 
layout. 

Window is resized. 
 

Drag a window edge to resize the window. 
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TIP 
- The initial window layout refers to the window layout when the application is first started after 

installation. 

- The size of the main window is not initialized. 

- The window layout of Viewer_1-4 Chart windows is not initialized. 

 

 
 

 
 
 

Click 
 

Layout of all windows other than the 
Viewer_1-4 Chart windows is initialized. 
 



 <4.  Basic Software Operations  > 73 
 

  IM 39J02B45-01E 
  

4.4.4 Menu Items for Displaying Dialogs (in main window) 
This subsection describes the displaying of dialogs from the main window menu. The 
table below lists the menu items (tabs, group boxes, buttons and menus) for displaying 
dialogs. 

Menu Element 
(Tab, group box, button or menu) Description 

Home (tab) 

  

DTS Control (group box) 
  Connect (button) Displays Connect dialog 
Wizard(*1) (group box) 

  
Fiber Connection (button) Displays Fiber Connection Calibration 

Wizard dialog 

Fiber Parameter (button) Displays Fiber Parameter Calibration Wizard 
dialog 

View (tab) 

  

Setting (group box) 

  
Sequence setting (button) Displays Sequence Setting dialog 
Channel Setting (Drop-down button) 

    Channel_1-16 (*2) (menu) Displays Channel_1-16 dialog 
Configuration (group box) 

  
CSV Save Config (button) Displays CSV Save Config dialog 
Trace Storage Config (button) Displays Trace Storage Config dialog 
Viewer Config (Drop-down button) 

      Viewer_1-4 Config (*3) (menu) Displays Viewer_1-4 Config dialog 
Tool (tab) 

  
Self Test (group box) 
  Self Test (button) Displays Self Test dialog 

*1: This item is displayed in calibration mode only. 
*2: In online state, menu options are listed for the number of channels installed in the DTSX200. 
 In offline state, menu options are listed for the number of channels selected in the Select Switch dialog. 
*3: Only Viewer_1 is displayed in calibration mode. 
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The display of the menu varies with the operation mode (Control, Monitor, Calibration or 
Trace) and the online/offline state as shown in the table below. 

Menu Element for Displaying Dialogs 
(tab, group box, button or menu) 

Online  Offline 
Contro

l Monitor Calibra
tion 

Contro
l Monitor Calibra

tion Trace 

Home (tab) Ο Ο Ο Ο Ο Ο Ο 

  

DTS Control (group box) 
Ο Ο Ο X X X X 

  Connect (button) 
Wizard (group box) 

X X Ο X X Δ X 
  

Fiber Connection (button) 
Fiber Parameter (button) 

View (tab) Ο Ο Ο Ο Ο Ο Ο 

  

Setting (group box) 

Ο Ο Ο Ο Ο Ο Ο 
  

Sequence setting (button) 

Channel Setting (Drop-down 
button) 

    Channel_1-16 
(*1) (button) Ο Ο Ο Ο Ο Ο Ο 

Configuration (group box) Ο Ο Ο Ο Ο Ο Ο 

  

CSV Save Config (button) X X X X X X Ο 
Trace Storage 
Config (button) Ο Ο Ο Ο Ο Ο Ο 

Viewer Config (Drop-down 
button) Ο Ο Ο Ο Ο Ο Ο 

      Viewer_1-4 
Config (*2) (menu) 

Tool (tab) Ο X Ο X X X X 

  
Self Test (group box) 

Ο X Ο X X X X 
  Self Test (button) 

Ο Displayed 
Δ Displayed but not selectable 
X Not displayed 
*1:  In online state, menu options are displayed for the number of channels installed in the DTSX200. 
 In offline state, menu options are displayed for the number of channels selected in the Select Switch dialog. 
*2:  Only Viewer_1 is displayed in calibration mode. 
 

4.4.5 Nodes for Displaying Dialogs (in Solution Tree Window) 
This subsection describes the displaying of dialogs from a node in the Solution Tree 
window. The table below lists the nodes for displaying dialogs. 

Nodes for Displaying Dialogs Description 
Control, Monitor, Calibration or Trace 

  

CSV Save Config Displays CSV Save Config dialog. 
Wizard(*1) 

  
Fiber Connection Displays Fiber Connection Calibration Wizard dialog. 
Fiber Parameter Displays Fiber Parameter Calibration Wizard dialog. 

Setting 

  

User Setting 

  
Sequence Setting Display and operation of Sequence Setting dialog. 
Channel Setting 
  Channel_1-16 (*2) Display and operation of Channel_1-16 dialog. 

Trace Storage Config Display and operation of Trace Storage Config dialog. 
Trace 

  
Viewer_1-4 (*3) 

  Config Display and operation of Viewer_n Config dialog (n matches 
the parent node).  

Self Test Displays Self Test dialog. 
*1: This item is displayed in calibration mode only. 
*2: In online state, nodes are displayed for the number of channels installed in the DTSX200. 
 In offline state, nodes are displayed for the number of channels selected in the Select Switch dialog. 
*3: Only Viewer_1 is displayed in calibration mode. 
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The display of the nodes varies with the operation mode (Control, Monitor, Calibration or 
Trace) and the online/offline state as shown in the table below. 

Nodes for Displaying 
Dialogs 

Online  Offline 

Control Monitor Calibrat
ion Control Monitor Calibrat

ion Trace 
Control, Monitor, 
Calibration or Trace Control Monitor Calibrati

on Control Monitor Calibrati
on Trace 

  

CSV Save Config X X X X X X Ο 
Wizard 

X X Ο X X Δ X   Fiber Connection 
Fiber Parameter 

Setting 

Ο Ο Ο Ο Ο Ο Ο 

  

User Setting 

  

Sequence 
Setting 
Channel 
Setting 

  Channel_
1-16 Ο(*1) Ο(*1) Ο(*1) Ο(*2) Ο(*2) Ο(*2) Ο(*2) 

Trace Storage 
Config Ο Ο Ο Ο Ο Ο Ο 

Trace 
Ο Ο 

Ο 
Ο Ο 

Ο 
Ο   Viewer_1-4 Ο(*3) Ο(*3)   Config 

Self Test Ο X Ο X X X X 
Ο Displayed 
Δ Displayed but not selectable 
X Not displayed 
*1:  Nodes are displayed for the number of channels installed in the DTSX200. 
*2:  Nodes are displayed for the no. of channels selected in the Select Switch dialog. 
*3:  Only Viewer_1 is displayed. 
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4.4.6 Dialog Operations 
This subsection describes basic dialog operations. 
A dialog is displayed as a pop-up window. While a dialog is displayed, displaying 
another window or dialog and working on another displayed window are not allowed. 
Dialogs cannot be resized and do not allow complex operations available with normal 
windows. 

TIP 
- Other windows or dialogs can be displayed or operated while a calibration-type dialog is displayed. 

(A calibration dialog can be operated alternately with a View_1 Chart window.) 

 

SEE ALSO 
For details, see Chapter 7, “Calibration Mode.” 

 

● Displaying a dialog 
A dialog can be displayed by clicking on its associated button in the main window or 
double-clicking on its associated node in the Solution Tree window. 

 

 
 

Click 
 

Double-click 
 

Dialog is displayed. 
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● Closing a dialog 
Clicking a button at the bottom of a dialog or the [x] button at the top right corner of a 
dialog closes the dialog. 

TIP 
- The buttons displayed at the bottom of a dialog vary with the dialog and may include [OK], 

[Cancel], [Close] and other buttons. For details, see the description of each dialog. 

 

 
 
 
 

Closes the dialog. 
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4.5 Starting and Stopping Measurement  
You can start, as well as stop measurement by the DTSX200 from the menu of the main 
window or a context menu in the Solution Tree window. 
Starting and stopping measurement is allowed only when the DTSX200 is connected 
online in control or calibration mode. 
Moreover, measurement can be started only when it is not in progress and conversely 
can be stopped only when it is in progress.  
 

Menu or Context  
Menu Item 

Online State 
Offline State 

Control Monitor Calibration Trace 

Start Ο(*1) X Ο(*1) X X 

Stop Ο(*2) X Ο(*2) X X 
Ο Displayed 
X Not displayed 
*1: Executable when connected to DTSX200 and measurement is not in progress 
*2: Executable when connected to DTSX200 and measurement is in progress 
 
 

4.5.1 Starting Measurement from Menu (in main window) 
This subsection describes how to start and stop measurement by the DTSX200 from 
the menu in the main window. To start measurement, select Home>DTS Control>Start. 
To stop measurement, select Home>DTS Control>Stop. 
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4.5.2 Starting Measurement from Context Menu (in Solution 
Tree window) 
This subsection describes how to start and stop measurement by the DTSX200 from a 
context menu in the Solution Tree window. 
 

     
 

● Procedure for starting measurement in control mode 
You can start measurement in control mode using the following procedure provided the 
DTSX200 is connected online: 
1.  Right-click on the Control node. 
2.  Select Start from the displayed context menu. 

● Procedure for stopping measurement in control mode 
You can stop measurement in control mode using the following procedure provided the 
DTSX200 is connected online: 
1.  Right-click on the Control node. 
2.  Select Stop from the displayed context menu. 

● Procedure for starting measurement in calibration mode 
You can start measurement in calibration mode using the following procedure provided 
the DTSX200 is connected online: 
1.  Right-click on the Calibration node. 
2.  Select Start from the displayed context menu. 

● Procedure for stopping measurement in calibration mode 
You can stop measurement in calibration mode using the following procedure provided 
the DTSX200 is connected online: 
1.  Right-click on the Calibration node. 
2.  Select Stop from the displayed context menu. 
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4.6 Status Display  
The status bar is displayed at the bottom of the main window. It displays the following 
status information.  
- DTSX200 error status 
- DTSX200 connection status 
- DTSX200 measurement status 
- DTSX200 measurement progress status 

 

 
 
 

4.6.1 DTSX200 Error Status 
A lamp is displayed at the leftmost end of the status bar. This lamp is lit in red if an error 
is detected on the DTSX200. Detailed error information can be checked on the 
maintenance screen of the DTSX200.  
The table below lists each color of the lamp along with its description. 
 

Lamp color Status 

Grey DTSX200 is not connected. 

Green No DTSX200 connection error 

Red DTSX200 connection error 

 

 
 
 

4.6.2 DTSX200 Connection Status 
The status of the connection to the DTSX200 is displayed to the immediate right of the 
DTSX200 error status lamp in the status bar. 
The table below lists each connection status display value with its description. 
 

Displayed connection status Status description 

Connect (IP address) Connected to DTSX200 at the displayed IP address 

Connecting ... Requesting for connection 

Retry connection Retrying to connect 

Idle Not connected 
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4.6.3 DTSX200 Measurement Status 
The DTSX200 measurement status is displayed to the immediate right of the DTSX200 
connection status in the status bar. 
The table below lists each measurement status display value with its description. 
 

Measurement status display Status description 

Run Measurement is in progress 

Run preparation Preparing for measurement 

Stop Measurement is not in progress 

Stop preparation Preparing to stop measurement 

Unknown Unknown state 

 

 
 

 

4.6.4 DTSX200 Measurement Progress Status 
The DTSX200 measurement status is displayed at the rightmost end of the status bar 
as two substatuses: 
- Channel measurement progress status  
- Sequence measurement progress status  

● Channel measurement progress status 
The channel measurement progress status is displayed graphically as a progress bar, 
which grows as measurement progresses to completion. The channel number is 
displayed to the left of the progress bar. 
 

 
 

● Sequence measurement progress status 
The sequence measurement progress status is displayed graphically as a progress bar. 
In an example where a measurement sequence specifies measurement of channel 1 
followed by channel 2, the progress bar indicates 50% completion at the end of channel 
1 measurement and 100% completion at the end of channel 2 measurement. 
For details on measurement sequence, see Chapter 5, “Control Mode.” 
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4.7 Chart Display 
 

4.7.1 Displaying a Chart 
Temperature measurement data of the DTSX200 can be displayed in a chart. 
No chart is displayed when the software application is started. 

 
 
Double-clicking on Solution Tree>Trace>Trace>Viewer_1>Chart displays the Viewer_1 
Chart window shown in the figure below. 
 
Up to four chart viewer windows, named Vewer_1 to Viewer_4, can be displayed. 

 
 

Double-clicking on any of these nodes 
displays a chart window. 
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The same chart viewer window can also be displayed by selecting View>Viewer 
Chart>Viewer_1 Chart from the menu bar. 

 
 
 

4.7.2 Displaying a Chart Configuration Window 
The Chart Configuration Window is used to configure a chart viewer. 

 
 
Double-clicking on Solution Tree>Trace>Trace>Viewer_1>Config displays the Viewer_1 
Config window shown in the figure below. 

Double-clicking on any of these nodes 
displays a chart configuration window. 
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The four chart configuration windows, namely, Vewer_1 Chart to Viewer_4 Chart, 
correspond one-to-one to the four chart viewer windows (Viewer_1 Chart to Viewer_4 
Chart). 

 
 

The same chart configuration window can also be displayed by selecting View>Viewer 
Config>Viewer_1 Config from the menu bar. 
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4.7.3 Configuring Chart Display 
 

 
 

You can configure a chart display by selecting the Chart Setup tab in a chart 
configuration window. 
 

(1) Data Type 
Select the type of data to be displayed. 
Temperature: displays temperature data 
Signal Level: displays signal levels 
ST: displays Stokes signal levels. 
AS: displays anti-Stokes signal levels. 
CFL: displays loss (Calculated Fiber Loss) values.  

TIP 
The DTSX200 calculates temperature data from measured signal levels.  

The CFL waveform is obtained by eliminating the effect of temperature  from Stokes signal levels. As 
the correction value for the fiber loss for Stokes light is fixed at 1.2 dB/km, the CFL slopes downwards 
when fiber loss is significantly large, indicating a deteriorated optical fiber. However, the CFL result is 
only meaningful in single-ended measurement and does not indicate fiber loss in double-ended 
measurement where the measurement results of the forward and reverse directions are combined. 
Moreover, beware that the CFL is useful only as reference data but not for quantitative assessment of 
fiber loss.  
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(2) Channel 
Select the channel for chart display. 
You can select a channel being measured. 
 

(3) Temperature Unit 
Select the unit for temperature data. 
Available options are Celsius [degC], Fahrenheit [degF] and Kelvin [K]. 
 

(4) Depth / Distance 
Select the distance type. 
Depth: Depth, which starts from the well inlet position as 0 m and takes into 

consideration winding coefficient, is used as distance. 
Distance: Distance starting from the DTSX200 exit position as 0 m is used.  
 

(5) Depth / Distance Unit 
Select the unit for depth or distance. 
Available options are Meter [m], Yard [yd], Feet [ft] and Mile [mi]. 
 

(6) 3D 
Surface: Displays a 3D chart as a surface chart. 
Line: Displays a 3D chart as a line chart. 

TIP 
- Difference between Surface and Line Charts 

 In a surface chart, adjacent data points along the X-axis and Z-axis are joined by planes. In a line 
chart, adjacent data points along the X-axis are joined by a line. The figure below shows the 
surface chart and line chart for the same sample data.  

 

   
           Surface chart                                              Line chart 
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(7) Chart Type 
Select the chart type. 

- 2D 
Type Horizontal Axis (X) Vertical Axis (Y) 

X:Time –   
Y:Data 

Time Data (temperature or signal level or 
CFL) 

X:Depth(Distance) –   
Y:Data 

Distance Data (temperature or signal level or 
CFL) 

X:Data –   
Y:Time 

Data (temperature or signal level or 
CFL) 

Time 

X:Data –   
Y:Depth(Distance) 

Data (temperature or signal level or 
CFL) 

Distance 

 

- 3D 
Type Horizontal axis (X) Vertical axis (Y) Depth axis (Z) 

X:Time –  
Y:Data –  
Z:Depth (Distance) 

Time Data (temperature or 
signal level or CFL) 

Distance 

X:Depth(Distance) –  
Y:Data –  
Z:Time 

Distance Data (temperature or 
signal level or CFL) 

Time 

X:Data –  
Y:Time –  
Z:Depth(Distance) 

Data (temperature or 
signal level or CFL) 

Time Distance 

X:Data –  
Y:Depth(Distance) –  
Z:Time 

Data (temperature or 
signal level or CFL) 

Distance Time 

Note 
X:Time – Y:Data, X:Data – Y:Time, X;Time – Y:Data – Z:Depth and X:Data – Y:Time – Z:Depth cannot be selected if the 

selected channel has not been configured by selecting Trace Storage Config>Time Series Storage Config. For 
details, see Section 5.6, “Time Series Measurement.” 

(8) Display Number (available only in Trace mode) 
Specify the number of charts to be displayed from 1 to 32. If there are fewer loaded 
temperature data files than the specified display number, this setting is ignored and 
charts are displayed for the number of loaded temperature data files.   

TIP 
If a display number increases, the processing speed of application will become slow.   
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(9) Legend 

 
 
Specify how a legend (chart colors and data acquisition time) is to be displayed.  
Right: Displayed to the right of the chart. 
Bottom: Displayed below the chart. 
Off: Not displayed. 

(10) Temperature Scale 
Select the temperature scale as Auto or Manual. If you have selected Manual, specify 
the minimum and maximum values of the scale.  
The valid data range depends on the temperature unit setting as shown in the table 
below. 
 

Temperature Unit Maximum value Minimum value Setting resolution 
Celsius[degC] 1000 -1000 1 
Fahrenheit[degF] 2000 -2000 1 
Kelvin[K] 1300 -1300 1 

 (11) Depth(Distance) Scale 
Select the depth (distance) scale as Auto or Manual. If you have selected Manual, 
specify the minimum and maximum values of the scale.  
The valid data range depends on the Depth / Distance Unit setting as shown in the table 
below. 
 

Depth/Distance Unit Maximum value Minimum value Setting resolution 
Meter[m] 10000 -10000 1 
Yard[yd] 11000 -11000 1 
Feet[ft] 32000 -32000 1 
Mile[mi] 6.000 -6.000 0.001 

 
 

Legend 
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4.7.4 Specifying Chart Colors 

 
 

You can specify colors for chart lines by selecting the Color tab in the Chart 
Configuration window. 
Clicking on the colored rectangle to the right of any of the 32 chart lines (Line1-32) 
displays a Color dialog for color selection.  
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4.7.5 Specifying the Data Display Range (available only in 
Trace mode) 
 

 
 
You can specify the starting data number for chart display by selecting View>Scaling of 
trace database from the menu. 
Data number begins with 1 denoting the most recent data and increments by 1 for 
successively older data.  
You may specify a starting data number either by entering a value in the Data Number 
field or by moving the slider. When you press the [Set] button, the chart display is 
updated to display data starting from the specified data number. 

TIP 
The total number of data sets is the number of available measurement data sets for the channel 
specified on the Chart Setup tab (see Subsection 4.7.3).   

 

Data Number field 

Slider 

Total number of 
data sets 

[Set] button 
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4.7.6 Chart Display Functions 
You can execute various display functions in a Chart Viewer window either directly using 
mouse operations or by right-clicking the mouse button in the window and selecting a 
function from the displayed context menu. The executable functions differ in 2D and 3D 
display. The tables below list and describe these functions. 
 

(1) Mouse operations 
Function 2D 3D Description 

Zoom Ο X You can enlarge or reduce the display by dragging the mouse. Drag 
the mouse from the upper left to the lower right to zoom in and drag 
the mouse from the lower left to the upper right to zoom out. You can 
also zoom out by selecting Zoom Out from the context menu. 

Pan Ο X Clicking on an arrow displayed at the end of a scale in a Chart Viewer 
window moves the scale and the display in the direction of the arrow.  

 

(2) Context menu operations 
Function 2D 3D Description 

Copy Ο Ο Copies the chart display to the clipboard. 
Save Ο Ο Saves the chart display to a file in BMP, JPG, WMF, EMF, GIF, PNG or 

TIFF format.  
Print Ο Ο Prints the chart display in fixed A4 size and landscape orientation.   
Print Preview Ο Ο Prints a preview of the chart display. You can modify the print size, color 

and other properties before printing. 
Transparency Ο Ο Sets the transparency of waveform display to 50% (The default is 0%). 
Guide Line Ο X Displays guidelines (a horizontal line and a vertical line), which track the 

mouse pointer. 
Display Value Ο X Displays mouse pointer position values. 
Zoom Out Ο X Undoes the last zoom operation. 
Default Scale Ο X Restores default scale, undoing all zooming. 
Scale X Ο Select the scale factor for the entire chart from 10% to 100% in 

increments of 10%. 
Rotate X Ο When rotation is enabled, you can change the view point of a chart 

display by dragging the Chart window. 
Z Scale X Δ Shows the scale of the Z-axis (applicable only to surface chart). 

 

(3) Calibration mode specific operations (available only during Fiber 
Connection Calibration) 

- Mouse operations 
Function Description 

Move marker When you click a marker to be moved, a yellow band indicating the allowable range 
for movement and a red broken line indicating the new marker position after 
movement are displayed. Dragging the red broken line using the mouse moves the 
marker. (The “S” marker representing the starting point cannot be moved.) 

 

- Context menu operations 
Function Description 

Marker>Add Adds a marker. A yellow band indicating the allowable range for adding a marker is 
displayed. Clicking the left mouse button at any position within the yellow band adds a 
marker at that position. 

Marker>Remove Deletes a marker. Select any marker from C1 to C10 to be deleted. 

TIP 
You can also add, delete or move a marker on the Fiber Connection Calibration dialog. 
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4.8 Messages 
Selecting View>Windows>Message in the main window displays (or if already 
displayed, gives focus to) the Message window. The Message window can also be 
displayed by double-clicking on the Message node in the Solution Tree window.  
The Message window displays various information and errors. The displayed 
information includes the time of occurrence, message type, message number and 
message text. 
 

 
 

The following types of messages may be displayed. 
Type Description 

Normal Normal information 
Error An error has been detected (but the application can continue execution.) 
FatalError An error has been detected (and the application cannot continue execution.) 
Warning A warning has been detected (but the application can continue execution.) 
Terminated The application is terminated. 

 

 IMPORTANT 
 

- If an Error type message is displayed, the application can continue execution but 
there may be some limitations on its operation thereafter. 

- If a FatalError type message is displayed, it will be followed by a “Terminated” type 
message and the application will be aborted. 
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4.9 Alarms 
Selecting View>Windows>Alarm in the main window displays (or if already displayed, 
gives focus to) the Alarm window. The Alarm window can also be displayed by double-
clicking on the Alarm node in the Solution Tree window.  
The Alarm window displays DTS failure information and temperature alarm information. 
 

 
 

● DTS Failure buttons 
The DTS failure button indicators indicate whether a DTS failure has been detected. If 
an error or warning has been detected, the corresponding error or warning button turns 
red. The button reverts to its original color when the error or warning condition is no 
longer present.  

SEE ALSO 
Details on a detected error or warning can be checked from maintenance window of the DTSX200. 

 

● Alarm buttons 
The Alarm button indicator for each channel indicates whether a temperature alarm has 
been detected for the channel. If a temperature alarm has been detected for the most 
recent data, the corresponding channel button turns red. If a temperature alarm has 
been detected for earlier data, the corresponding channel button appears yellow.  
Clicking a red or yellow alarm button displays details of the alarm as shown in the figure 
below.  

SEE ALSO 
For details on how to define temperature alarms, see Chapter 5.6 , “Displaying Temperature Alarms.” 

 

 
 

●  [CLR] button for clearing temperature alarms (This button is not 
displayed in Trace mode) 
Clicking the [CLR] button clears all temperature alarm information and restores all alarm 
buttons to default color. 
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4.10 Help 
Clicking on the [?] button located at the upper right corner of the main window displays 
the Information dialog window. The window displays version information about the 
software in offline state and additional information about the DTSX200 in online state. 
 

 
 

The following types of information are displayed in the Information window. 
Displayed Item Description 

Software Version Version of the software 
Firmware Version Version of the firmware of the connected DTSX200 
LAS 2.0 Data Conversion “Active” or “Inactive” is displayed if the LAS 2.0 conversion 

function installed in the connected DTSX200 is enabled or 
disabled respectively. 

WITSML 1.3.1.1 Data 
Conversion 

“Active” or “Inactive” is displayed if the license for the WITSML 
1.3.1.1 conversion function of the connected DTSX200 is 
enabled or disabled respectively. 

FPGA Version FPGA version of the connected DTSX200 
Board Version Board version of the connected DTSX200 
Model and Suffix Codes Model name and suffix codes of the connected DTSX200 
Serial No. Serial number of the connected DTSX200 
MAC Address MAC address of the connected DTSX200 
Switch Model and Suffix 
Codes 

Model number and suffix codes of the optical switch of the 
connected DTSX200 (if an optical switch is installed) 

Switch Serial No, Serial number of the optical switch of the connected DTSX200 (if 
an optical switch is installed) 

Number of Switch Channels Number of channels of the optical switch of the connected 
DTSX200 (if an optical switch is installed) 

 
Clicking the [Manual] button displays the user manual, which is in PDF format. Software 
capable of displaying PDF files must be pre-installed on the PC to view the user 
manual. 
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5. Control Mode 
 

5.1 Control Mode Functions 
The Control mode is used for setting various measurement parameters of the 
DTSX200, as well as starting and stopping measurement by the DTSX200. 
 

(1) Setting Measurement Parameters 
Measurement parameters include measurement-related settings and calculation-related 
settings. The former is used for configuring measurement of Raman scatter signal 
levels while the latter is used for configuring temperature data calculation using 
measured signal level data.   
 
The software supports recalculation of temperature data so any modification to 
calculation-related settings during measurement or after measurement completion is 
reflected in measurement result display. 

TIP 
- Any modification to calculation-related settings during measurement or after measurement 

completion is reflected only in measurement result display but not in saved measurement result 
data. 

 

(2) Starting and Stopping Measurement 
You can start and stop measurement by the DTSX200 by clicking the [Start] button and 
[Stop] button respectively.   

(3) Saving Measurement Result Data 
The software allows trace data (measurement result data) of the DTSX200 to be saved 
on a PC. 
Moreover, time series data can be saved for use in time series chart display (with time 
on the X-axis). 
Data saved to a PC can be retrieved in Trace mode after measurement completion.    

TIP 
- Measurement result data and time series data can be saved only when the software is connected 

to the DTSX200. 

 Measurement result data and time series data cannot be saved when the software is not running or 
when the software is disconnected from the DTSX200 due to communication error or some other 
reason. 

- Measurement result data is known as trace data, files containing trace data are known as trace 
files and folders containing trace files are known as trace folders. 

 

(4) Measurement Result Display 
Measurement result data of the DTSX200 can be displayed as charts. 
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(5) Status Display 
Status display functions include DTSX200 status display and software status display. 
• DTSX200 status display 
- Alarm window:  

 Displays status information on temperature alarms detected by the DTSX200, 
as well as failure/error status of the DTSX200. 

- Status bar (measurement status display):  
 Displays measurement status information (whether measurement is in 

progress or not) and measurement progress status information (percentage 
completion). 

• Software status display 
- Message window:  

 Displays various errors and warnings detected by the software. 
- Status bar (connection status display):  

 Displays the status of the communication connection between the software 
and the DTSX200. 

(6) Self-test Execution 
Self test of the DTSX200 can be executed and the test result displayed from the Self 
Test dialog. 
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(7) Enabled and Disabled Functions 
Individual functions of Control mode may be enabled or disabled depending on the 
system status as shown in the table below.  

Function Window, Dialog or Button 

System Status 

Offline 
state 

Online state 
Connected to DTSX200 Disconnecte

d from 
DTSX200 

Measurement 
in progress 

Measurement 
not in 

progress 

Setting 
measurement 
parameters 

Sequence Setting dialog Ο Δ(*1) Ο Δ(*1) 
Channel Setting dialog 
(excluding Fiber Setting tab) Ο Δ(*1) Ο Δ(*1) 

Channel Setting dialog (Fiber 
Setting tab) Ο Δ(*1) Ο(*2) Δ(*1) 

Starting and 
stopping 
measurement 

Start button X X Ο X 

Stop button X Ο X X 

Saving 
measurement 
result 

Trace Storage Config dialog Ο Δ(*1) Ο Δ(*1) 

Measurement 
result display 

Viewer Chart window X Ο X (*3) X (*3) 
Viewer Config dialog Ο Ο Ο Ο 

Status display 

Alarm window X Ο Ο X (*3) 
Message window Ο Ο Ο Ο 
Status bar (Measurement status 
display) X Ο Ο X 

Status bar (Connection status 
display) Ο Ο Ο Ο 

Self-test 
execution Self Test dialog X X Ο X 

*1: Display only. No modification is allowed. 
*2: Any modification to settings is reflected in measurement result display but not in saved measurement result data. 
*3: Displays the status at the time of the last measurement. 
Ο: Enabled 
Δ: Enabled but with restrictions 
X: Disabled 
  A disabled dialog cannot be displayed. 
  A disabled window is displayed but not updated. 
  A disabled button cannot be pressed. 
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5.2 Preparing for Measurement 
Before starting measurement, you need to specify measurement parameters and 
configure the saving of measurement results.  

SEE ALSO 
For details on how to set measurement parameters, see sections of Chapter 5, starting from Section 
5.3. 

 

 Saving measurement results 
The software allows measurement result data of the DTSX200 to be saved to files on a 
PC. Files containing saved measurement result data can be used for chart display. 

TIP 
The following terms will be used hereafter. 

- Trace data refers to measurement result data. 

- Trace file refers to a file containing trace data. 

- Trace folder refers to a folder storing trace files. 

 
Two types of measurement result data can be saved to a trace folder. 
 
1.  Trace data (measurement result data) 
Trace data refers to measurement result data of the DTSX200. By saving trace data, 
measurement result can be displayed in a chart with distance on the X-axis. 

 
2.  Time series data 
Time series data records temperature changes over time at a specified depth. By saving 
time series data, measurement result can be displayed in a chart with time on the X-
axis. 
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● Trace Storage Config dialog 
The Trace Storage Configuration dialog can be displayed by double-clicking on the 
Trace Storage Config node in the Solution Tree window as shown in the figure below. 

 

TIP 
- Trace data and time series data can be saved only when the software is connected to the 

DTSX200. 

- Trace file refers to a file containing trace data. Trace data and time series data cannot be saved 
when the software is not running or when the software is disconnected from the DTSX200 due to 
communication error or some other reason. 

 

Trace storage configuration 
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● Trace File Storage Config tab 

 
Selecting the Trace File Storage Config tab displays a tab window for configuring the 
storage of trace data (measurement result data). 
You can specify the trace storage folder, as well as whether trace data storage is to be 
limited by the amount of free space left. If a free space limit is specified, trace data 
storage and measurement result display stop when free space falls below the specified 
limit.    
 
To configure storage of trace data: 
1.  Under Storage Management, select whether trace data storage is to be Limited by 

free space or Unlimited. 
2.  If you have selected for storage to be limited by free space, specify a free space 

limit from 1.0 [Gbyte] to 100000.0 [Gbyte]. 
3.  In the Save Folder field, specify a trace folder for storing trace files. If the specified 

folder does not exist, an error will be reported when you press the [OK] button. 

TIP 
- Trace data storage cannot be turned off. Therefore, we recommend to delete unwanted trace 

folders and trace files regularly. 

- Even if you have selected Unlimited for storage management, if the specified trace folder is on a 
system drive (C:), trace data storage stops automatically when free space on the drive is about 1 
gigabyte or less. 

- The specified free space limit is observed by the software but not strictly. 

- We recommend specifying a trace folder on an internal hard disk of the PC. If a network drive is 
specified, communication error may cause trace data storage or time series data storage to fail. 

 
 

Trace data storage configuration 
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● Time Series Storage Config tab 

 
Selecting the Time Series Storage Config tab displays a tab window for configuring the 
storage of time series data. 
You can specify whether to enable or disable storage of time series data, as well as 
specify a list of depths for saving temporal temperature data for each optical switch 
channel using the following procedure. 
 
1.  Select the Use checkbox to enable time series data storage; deselect the checkbox 

to disable time series data storage. 
2.  If the Use checkbox is selected, the Depth list for time series storage column 

displays a list of depths for storing temporal temperature data for each individual 
optical switch channel. 

3.  To specify the depth list for time series data storage for a channel, display the Time 
Series Storage Config dialog. To do so: 
 Double-click on the required channel in the Ch list; or 
 With the required channel selected, click the [Property] button. 

4.  You can copy the depth list of one channel to another channel. To do so, select the 
source channel from the Ch list and click the [Copy] button. Next, select the 
destination channel and click the [Paste] button. 

TIP 
- If a specified depth is outside the measurement range, 0°C is stored. 

- Up to 3000 time series data points can be stored. If more than 3000 data points are measured, the 
most recent 3000 time series data measurements are stored. 

- If continuous measurement is interrupted by communication problem, DTSX200 reboot or some 
other reason, time series data will be stored up to measurement interruption. 

 

Time series data storage 
configuration 
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The Time Series Storage Config_nn dialog is used to specify a depth list for time series 
data storage for a channel.  
You can specify whether to enable or disable time series data storage for the channel, 
as well as specify a list of depths for storing temporal temperature data. 
 
1.  Select the Use checkbox to enable time series data storage for the channel; 

deselect the checkbox to disable time series data storage. 
2.  To add a depth for temporal temperature data storage to the depth list, enter a value 

from 0.0 to 30000.0 [m] in the Depth field shown in the figure above, and click the 
[Add] button. The entered depth is added to the depth list. 

3.  Up to 32 depths can be specified for temporal temperature data storage. 
4.  To delete all depths in the list, click the [Clear] button. 
5.  To delete a depth from the list, select the depth to be deleted and click the [Delete] 

button. 
 

Depth field 
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● Trace file structure 

 
Consider an example where the destination for storing a trace folder is specified in Save 
Folder as “C:\Trace” as shown in the figure above. The resultant trace folder and file 
structure is shown in the figure below. 

 
A trace folder is created below the “C:\Trace” folder by the DTSX200 at the beginning of 
each measurement. 
 The first digit of the trace folder name indicates the application launch ID and the next 
14 digits indicate the measurement start time (YYYYMMDDhhmmss). 

TIP 
- Do not change the structure or names of subfolders and files below a trace folder. Otherwise, data 

loading by the software may fail or an error may occur after loading. 

- Always specify a trace folder when copying or deleting trace data. Loading by the software will fail 
if only subfolders or files under a trace folder are copied. 

- The measurement start time is acquired from the DTSX200. 

 
 

Trace folders 
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Trace file folders, configuration files and time series data files are created below a trace 
folder. 
1.  A new trace file folder is created each time 100 trace files have been created. Trace 

file folders are assigned names serially starting from 0. 
2.  Configuration files store settings prevailing at the time of measurement. 
3.  A time series data file is created for each optical switch channel. 

 
Trace files are created below a trace file folder. 

Configuration files Time series data files 

Trace file folder 
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The trace file name begins with the letter t followed by 14 digits indicating the end time 
of each measurement (YYYYMMDDhhmmss), the letter c and 2 digits indicating the 
optical switch channel number. 

TIP 
- Configuration files, time series data files and trace files have non-published, proprietary formats. 

- Do not modify the content of configuration files, time series data files and trace files. Otherwise, 
data loading by the software may fail or an error may occur after loading. 

- The measurement end time is acquired from the DTSX200. 

 

The table below shows a sample trace folder/file structure. 
Folder Structure Description 

C:\Trace Destination for storing trace folder specified in Save Folder 
 120110722173446  Trace folder (created at the beginning of each measurement) 
  0   Trace file folder 0 
  1   Trace file folder 1 
  2   Trace file folder 2 
 120110726101750  Trace folder (created at the beginning of each measurement) 
  0   Trace file folder 0 
 220110723181227  Trace folder (created at the beginning of each measurement) 
  0   Trace file folder 0 
 320110718105637  Trace folder (created at the beginning of each measurement) 
  0   Trace file folder 0 
  1   Trace file folder 1 

File Structure Description 
 120110722173446  Trace folder (created at the beginning of each measurement) 
  UserSetup.dsu   Configuration file 
  InternalSetup.dsi   Configuration file 
  InitialInfo.ddi   Configuration file 
  TraceTimeseries0.ddr   Time series data file (for optical switch channel 1) 
  TraceTimeseries1.ddr   Time series data file (for optical switch channel 2) 
  0   Trace file folder 0 
   t20110726101813c01.ddt    Trace file (measurement result file) 
   t20110726101818c02.ddt    Trace file (measurement result file) 
   t20110726101828c01.ddt    Trace file (measurement result file) 
   t20110726101834c02.ddt    Trace file (measurement result file) 
   t20110726101845c01.ddt    Trace file (measurement result file) 
   t20110726101852c02.ddt    Trace file (measurement result file) 

Bolded text indicates a folder name. 
Shaded text indicates a file name. 
Underlined text indicates a trace folder name which can be specified for loading in Trace mode. 
Italicized text indicates a trace file name which can be specified for loading in Trace mode. 
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5.3 Single-ended Measurement 
The DTSX200 supports both single-ended and double-ended temperature 
measurement. In single-ended measurement, a light pulse is launched from one end of 
the optical fiber and the returned Raman scatter is measured to determine temperature 
distribution. In double-ended temperature measurement, a light pulse is launched from 
each of the two ends of the optical fiber and the returned Raman scatter is measured 
separately to determine temperature distribution. This Section describes how to perform 
single-ended measurement. 

SEE ALSO 
For details on single-ended measurement, see “Single-ended Measurement and Double-ended 
Measurement” of the DTSX200 Guide (IM39J06B45-01E). 

 
1.  First, display the Sequence Setting dialog to configure a measurement sequence. 
2.  On the Sequence Control tab window, select the Sequence Mode as Single or 

Continuous.  

SEE ALSO 
For details on the single and continuous sequence modes, see Section 5.5, “Single and Continuous 
Sequence Measurement.” 

 
3.  Define a sequence table on the Sequence Table tab window. 
- Temperature measurement proceeds in ascending order of No. for channels whose 

Use checkbox is selected. 
- Select SingleEnd from the pull-down menu of Principle for single-ended 

measurement. 
- Select the channel to be measured from the pull-down menu of Channel(Near). 
- Specify a sequence interval in Interval[sec]. 
4.  After editing is completed, click [OK]. The settings are saved and the dialog closes. 

Clicking [Cancel] closes the dialog without saving edited settings. 
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Item Description Type 
No. Indicates the order in the measurement sequence. － 
Use Enables or disables measurement for a channel. M 

Principle Select either SingleEnd or DoubleEnd for single-ended or double-ended 
measurement respectively. 

M 

Channel (Near) Select the near-end measurement channel. M 
Channel (Far) Select the far-end measurement channel.  M 
Interval [sec] Specify a sequence interval. M 

* Type M indicates a measurement-related setting. 
 

TIP 
- The Channel(Far) setting is disabled if single-ended measurement is selected. 

- If the specified sequence interval is shorter than the measurement time, the following 
measurement starts immediately. 

- If an entered sequence interval is invalid, it is reverted to its original value and an error provider is 
displayed at the row header . 

- Clicking [OK] with no Use checkbox selected or a duplicate channel number specified causes an 
error message to be displayed. 

 
5.  Next, display each Channel_n dialog (where n denotes a channel number) to 

configure each channel in turn. 
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6.  Specify each parameter on the Measurement Control tab. The following table 
describes each parameter. 

Item Description Type 

Repetition Rate 
This parameter determines the rate for pulse repetition.  
Select Standard Rate if the far-end of the fiber does not have anti-reflection 
termination to avoid measurement error due to reflection. 

M 

Distance Range The specified distance range must be longer than the fiber length. M 

Sampling 
Resolution 

This parameter determines the sampling resolution for A/D conversion. 
If the specified sampling resolution is shorter than 1 m, multi-sampling is 
performed by shifting the sampling time . 

M 

Averaging 

This parameter specifies the number of times measurement is to be repeated 
for averaging purpose. 
Averaging can be used to improve the signal-noise ratio when the Raman 
scatter signal level is very weak, If Measurement Time is selected, the 
specified measurement time is used to determine the number of 
measurements to be used for averaging. 

M 

Fiber Failure 
Detection 

Select the ON checkbox to enable fiber failure detection.  
If enabled, specify a threshold level for fiber failure detection. M 

Repetition Rate 
This parameter determines the rate for pulse repetition.  
Select normal rate if the far-end of the fiber does not have anti-reflection 
termination to avoid measurement error due to reflection. 

M 

* Type M indicates a measurement-related setting. 
 

TIP 
- The Measurement Time setting refers solely to the measurement duration for averaging. It does 

not include time for hardware preparation, temperature calculation, alarm detection, section data 
creation, file creation, data transfer and other auxiliary time. 

- Fiber failures that are close to the fiber near-end may fail to be detected. 
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7.  Next, specify each parameter on the Fiber Setting tab window. 

 
 
The following table describes each item on the Fiber Setting tab window. 

Item Description Type 
Optical Switch Exit 
Position This parameter defines the exit position of the optical switch. C 

Well Inlet Position This parameter determines the well inlet position. If Depth is specified for an 
axis in chart display, the well inlet position is displayed as 0 m. C 

Fiber Setting list The Fiber Setting section lists the settings for each fiber section. － 

Total Length This field displays the sum of the lengths of all fiber sections. － 

Fiber End This parameter defines the fiber end. Any position beyond this specified value 
is detected as fiber failure.  M 

[Add] button Clicking the [Add] button enables the row following the row currently enabled 
in the list. － 

[Insert] button Clicking [Insert] with any row in the list selected inserts a new enabled row 
and deletes the last row. － 

[Delete] button Clicking [Delete] deletes the selected row and adds a disabled row at the end 
of the list. － 

[Property] button 
Clicking [Property] with any row selected displays the Fiber Setting_* dialog 
(where * denotes the fiber section number). Double-clicking any row 
produces the same result. 

－ 

Fiber Setting_nn dialog is displayed. Calculation dialog is displayed. 

Click 

Double 
-click 
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Calculation Range 

Select the [Total Length] option to display chart data up to the total fiber 
length if data display beyond that is not required. Select the [All Data] option 
to display chart for all data used in temperature calculation.  
*  In Calibration mode, the [Total Length] option is not available and the [All 
Data] option is always used.  

C 

[Calculate 
Wavenumber] 
button 

Clicking [Calculate Wavenumber] displays the Calculation dialog. － 

* Type M indicates a measurement-related setting while type C indicates a calculated-related setting. 
 
Specify the calculation-related parameters for each fiber section using the Fiber 
Setting_nn dialog where nn denotes a fiber section number from 01 to 10. The table 
below describes the calculated-related parameters. 

Item Description Type 
Basic Parameters The section defines the basic fiber parameters. － 

 

Length Specify the fiber length of a fiber section. C 

Group Index Specify the group index of a fiber section. This parameter applies to a 
distance axis.  C 

Loss 
The Stokes and anti-Stokes signals of the Raman scatter suffer different fiber 
loss because of their different wavelengths. Specify the differential loss for a 
fiber section to correct for this temperature error.  

C 

Winding Coeff. Specify the winding coefficient of a fiber section. This parameter relates to 
depth.  C 

Correction This section defines the temperature correction for a fiber section. － 

 

Use Select this checkbox to enable temperature correction. C 
Linearity This parameter relates to the temperature scale. C 

Slope This parameter relates to the temperature slope.  
(* It represents the temperature change [degC] per 100 meters.) C 

Offset This parameter relates to the temperature offset. C 
Calibration This section defines temperature calibration for a fiber section. － 

 

Use Select this checkbox to enable temperature calibration. C 

 

Calibration 
Type Select the type of temperature calibration to be performed. － 

 

Manual Input Select this option to enable the Manual Input group box and use its settings 
for calibration. C 

Remote Input 

Select this option to enable the Remote Input group box and use its settings 
for calibration. 
* This option is valid only when a reference thermometer is available at a 
specified position and communication with the DTSX200 is open so that the 
thermometer temperature readings can be transmitted to the DTSX200. With 
this option, the DTS temperature measurement is calibrated using the 
transmitted thermometer readings and the DTSX200 measurement values at 
the same position. 

C 

Optical 
Switch 

Select this option to use settings stored in the optical switch memory for 
calibration.  
* This option can only be selected for the first fiber section. 
* If this option is selected but no optical switch is installed, temperature 
calibration is not performed. 

C 

Wavenumber This group box selects and defines the wavenumber to be used for 
temperature calculation. － 

 

Default Or  
Other 
Section 

Select this option to use the default wavenumber value or the wavenumber 
value specified for other fiber sections. 
* If wavenumber is specified for multiple fiber sections, their average value is 
used. 

C 

Setting Select this option to use the specified wavenumber value. C 

Remote Input Select this option to calibrate DTSX200 temperature measurement using data 
at a specified position. － 

 
Position Specify the position for temperature calibration. C 
Averaging 
Distance 

Specify the distance in meters centered on the specified position to be used 
for averaging. C 

Manual Input Select this option to calibrate DTSX200 temperature measurement using an 
actual thermometer temperature reading (temperature offset calibration). － 
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Thermometer 
reading Specify the thermometer temperature reading (actual value). C 

DTS reading Specify the DTSX200 temperature measurement reading. C 
* Type C indicates a calculated-related setting. 
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The well inlet position and winding coefficient parameters are used for converting 
distance to depth as shown in the example below. 

S W C01 E

Assuming that:
Well Inlet Position = 400m
For Internal Section & Section 1, Winding Coeff. = 1, 
For Section 2, Winding Coeff. = 2

When position is 
represented as distance:

0m 100m 400m 800m

Section 1 Section 2

When position is 
represented as depth:

W C01

-300m 0m

Section 1 Section 2
S

-400m 200m

Internal
Section

S : Start Position
W : Switch Exit Position
C01 : Connection Position
E : End Position

EInternal
Section

 
 
The Calculation dialog can be used for calculating the wavenumber. The table below 
describes the settings in this dialog. 

Item Description 
Normal 
Temperature Specify settings for normal (low) temperatures. 

 

Thermometer 
Reading Specify a thermometer temperature reading. 

DTS Reading Specify the DTSX200 measured temperature before temperature calibration. 

Heated 
Temperature Specify settings for high temperatures. 

 
Thermometer 
Reading Specify a thermometer temperature reading. 

DTS Reading Specify the DTSX200 measured temperature before temperature calibration. 
[Calculate] button Clicking [Calculate] begins wavenumber calculation. 
Wavenumber The calculated wavenumber is displayed in this field. 

[Copy] button Clicking [Copy] updates the specified fiber section with the calculated wavenumber. 
(The value is updated to the specified fiber section in the Fiber Setting list.) 

To Fiber Section Select the fiber section to be updated with the calculated wavenumber. 
[Close] button Clicking [Close] closes the Calculation dialog. 
 

TIP 
- The Double End Setting tab is not displayed in the Channel dialog for a channel specified for 

single-ended measurement. 

- Except for the Fiber End parameter, all parameters on the Fiber Setting tab window are calculation-
related settings. Modification to any of these parameters even after measurement completion can 
be reflected on displayed charts. 

- Settings on the Fiber Setting_nn dialog and Calculation dialog correspond to the Fiber Parameter 
Calibration dialog of Calibration mode. For details on how to specify each parameter, see Chapter 
7, “Calibration Mode.” 

 
8.  After specifying all the required settings, check that the sensing fiber is properly 

connected to the DTSX200 and then click the [Start] button on the main window to 
start measurement. 
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9.  When measurement completes, the chart display is updated. Thereafter, the next 
measurement is started according to the specified Interval on the Sequence Table 
tab of the Sequence Setting dialog. When measurement completes, the chart 
display is again updated. This process is repeated until the [Stop] button is clicked 
or the sequence ends. 
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5.4 Double-ended Measurement 
This section describes the procedure for performing double-ended measurement with 
light pulses launched from both ends of an optical fiber.  

SEE ALSO 
For details on the measurement method, see “Single-ended Measurement and Double-ended 
Measurement” of the DTSX200 Guide (IM39J06B45-01E). 

 
1.  Similarly to single-ended measurement, display the Sequence Setting dialog and 

specify the sequence settings. To specify double-ended measurement for a 
channel, select DoubleEnd from the pull-down menu of Principle on the Sequence 
Table tab window. When DoubleEnd is selected, Channel(Far) is enabled. Select 
the far-end channel from the pull-down menu of Channel (Far). 

 
 
2.  Next, display the Channel_n dialog for each channel (where n denotes the channel 

number) in turn and specify the channel settings. 
- Similarly to single-ended measurement, specify the measurement parameters on 

the Measurement Control tab window. 

TIP 
- In double-ended measurement, only the channel settings of the specified near-end channel 

(Channel(Near)) are used in measurement and calculation. Channel settings of the far-end 
channel (Channel(Far)) are disabled. The channel settings of the near-end channel are used for 
both forward direction measurement and reverse direction measurement. 

- Measurement is repeated for the number of times specified for averaging (Averaging Times) 
separately in the forward direction and reverse direction.   

- If Fiber Failure Detection is not turned on, a fiber failure, if it occurs, will not be detected so 
measurements from both directions will be combined, leading to incorrect measurement results. 

- Fiber failures that are close to the fiber near-end may fail to be detected. 

 

Settings for 
double-ended 
measurement 
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- Similarly to single-ended measurement, specify the various calculation parameters 
on the Fiber Setting tab window. 

TIP 
- For double-ended measurement, the Loss setting need not be specified because measurement 

results of the forward and reverse directions are combined. Even if specified, it will not affect the 
temperature calculation result. 

- However, the Loss setting is required when a fiber failure is detected. If this happens, the 
measurement results up to the fiber failure position of the forward and reverse directions are 
combined.   

 
- The Double End Setting tab is displayed for a channel configured for double-ended 

measurement. As measurement results of the forward and reverse directions are 
combined in double-ended measurement, loss correction is not required. However, 
absolute temperature correction is still required. In double-ended measurement, 
temperature correction is made for the total differential loss between the Stokes and 
anti-Stokes light over the full fiber length. 
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Item Description Type 

Setting 
Select this option and enter a value manually for the total differential loss 
between the Stokes and anti-Stokes signals over the full fiber length to 
perform temperature correction using this value.  

C 

Measurement 

Select this option to have the system automatically determine by 
measurement the total differential loss between the Stokes and anti-Stokes 
signals over the full fiber length and use it for temperature correction. Specify 
near-end and far-end positions for differential loss measurement as described 
below. 

C 

 

Near End Group box for specifying a near-end position for differential loss 
measurement. － 

 

Distance Of W 
To P1 

Specify position P1 of constant temperature by its distance from the switch 
exit position. C 

Averaging 
Distance Specify the distance in meters centered on P1 to be used for correction. C 

Far End Group box for specifying a far-end position for differential loss measurement. － 

 

Distance Of W 
To P2 

Specify position P2 of constant temperature by its distance from the switch 
exit position. C 

Distance Of E 
To P2 Specify position P2 of constant temperature by its distance from the fiber end. C 

Averaging 
Distance Specify the distance in meters centered on P2 to be used for correction. C 

Switch Exit 
Position This field displays the switch exit position. － 

End Position This field displays the total fiber length.  
* It displays the Total Length value on the Fiber Setting tab. － 

* Type C indicates a calculation-related setting. 
 

TIP 
- If you have selected Setting, we recommend using the default value of 0.220 [dB/km] for 

Differential Loss. Enter 0.000 [dB/km] to perform no correction. 

- If you have selected Measurement, beware that the temperatures of the specified near-end and 
far-end positions must be the same. 

- With the Measurement option, if continuous sequence mode is selected, differential loss is 
averaged over the repeated measurements. This improves the accuracy especially for the far-end 
where signal-to-raise ratio is poor.   

- Beware that the Distance Of W To P1 and Distance Of W To P2 settings refer to distances from the 
switch exit position but not distances from the DTSX200 exit position. 

 
3.  After specifying all the required settings, check that the sensing fiber is correctly 

connected to the DTSX200 and click the Start button on the main window to start 
measurement. 

 
4.  When measurement completes, the chart display is updated. Thereafter, the next 

measurement is started according to the specified Interval on the Sequence Table 
tab of the Sequence Setting dialog. When measurement completes, the chart 
display is again updated. This process is repeated until the [Stop] button is clicked 
or the sequence ends. 
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● When fiber failure is not detected 
 
Example: Signal Level 

 
 
Example: Temperature 

 
 

Measurement results of the forward 
and reverse directions are 

combined. 
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● When fiber failure is detected 
 
Example: Signal Level 

 
 
Example: Temperature 

 
 
 
 

Forward measurement Reverse measurement 

Fiber failure 
position 
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5.5 Single and Continuous Sequence 
Measurement 
You can select to execute a measurement sequence repeatedly or only once by 
selecting Continuous or Single respectively for Sequence Mode in the Sequence 
Setting dialog.   

 
 
If you have selected continuous sequence execution,  you can specify a fixed sequence 
interval or specify a table of start times for repeating the sequence execution by 
selecting Sequence Interval or Sequence Start Time respectively for Repetition Mode. 
Finally, you can select to apply the entered list of start times every day or once only by 
selecting Every Day or 1 Cycle for Start Time Setting. The flowchart below illustrates the 
various setting options available. 

Single

Continuous Sequence Interval

Sequence Start Time Every Day

1 Cycle

Sequence 
Mode

Repetition Mode

Start Time Setting

Specify up to 6 values 
in Start Time Table.

Specify Interval value.
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The table below lists and describes each parameter in the Sequence Setting dialog. 
Item Description Type 

Power Save Mode Select this checkbox to enable power saving mode. M 

Sequence Mode Select whether to execute the measurement sequence defined on the 
Sequence Table tab window only once or repeatedly. M 

 

Continuous Select this checkbox to execute the sequence repeatedly according to the 
specified Repetition Mode. M 

 

Sequence 
Interval 

Select this checkbox to specify a fixed interval for repeating sequence 
execution.  
Sequence execution begins when measurement is started and when the 
sequence is completed, it is repeated after waiting according to the specified 
Interval. The specified interval defines the interval between the starting times 
of two successive sequence executions. If the specified interval is shorter 
than the time for one sequence execution, the next sequence execution 
begins immediately after the current sequence execution ends.  

M 

Sequence Start 
Time 

Select this option to specify up to 6 start times in the Start Time Table for 
repeating sequence execution. If the next specified start time is exceeded 
when a sequence execution ends, the next sequence execution begins 
immediately. 

M 

 

Every Day Select this option to begin sequence execution at each start time specified in 
the Start Time table every day. M 

1 Cycle Select this option to perform one cycle of sequence executions according to 
the start times specified in the Start Time table.  M 

Start Time 
Table 

You can specify up to six start times. Sequence execution is carried out in 
ascending order of No.  
No. : Displays a read-only running number. 
Use: Select this checkbox to enable a start time setting. 
Hour: Specify the hour for the start time as an integer from 01 to 23. 
Minute : Specify the minute for the start time as an integer from 0 to 59. 

M 

Single Select this option to execute the measurement sequence only once. M 
* Type M indicates a measurement-related setting. 
 

TIP 
- If an entered Hour or Minute value in the Start Time Table is invalid, an error provider is displayed 

at the beginning of the input row. 

- When the focus is moved out of the Start Time Table, the start time values entered in the table are 
automatically sorted in ascending order. 

- If a start time is repeated in the Start Time Table, the measurement sequence is executed only 
once at the start time. 
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5.6 Temperature Alarm Display 
 

● Defining Alarms on Alarm Setting tab 

 
 

You can define up to 10 alarm sections for alarm detection.  
Moreover, each alarm section can be enabled or disabled individually using a Use flag. 
- Specify the Start Depth and Depth (distance from the Start Depth) for each alarm 

section. 
- The Depth and Start Depth can be specified as any value from 0.1[m] to 30000.0 

[m] with resolution of 0.1 [m]. 
- The End Depth is calculated automatically and thus need not be specified. 
- When specifying contiguous alarm sections where the Start Depth of a section 

coincides with the End Depth of the previous section, you can save typing by 
deselecting the STR checkbox. 

- If an entered Start Depth is before the End Depth of the preceding section, an error 
is reported is the entered value is rejected. 

 
 
 

Section 1 

Depth 

Section 2 
Depth[m] 

Start 
Depth End 

Depth 

Depth Start 
Depth 

Section 3 

End 
Depth 
Start 
Depth 

End 
Depth 

250 200 100 350 450 
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Clicking the [Setting] button in an alarm section row on the Alarm Setting tab window 
displays the following pop-up dialog window for detailed configuration of the alarm 
section.  

 
 
Each of the 7 available alarm types can be enabled or disabled individually for each 
individual alarm section. The table below lists each alarm type along with the condition 
for alarm detection and the valid data range for specifying the alarm limit.  
All alarm limit values can be specified with resolution of 0.01 [degC]. 
 

Alarm Type Alarm Condition Setting Range 
Temperature High Limit Measured value > Limit -273.15 ≤  Limit ≤  99999 
Temperature Low Limit Measured value < Limit -273.15 ≤  Limit ≤  99999 

Temperature Rise Limit 
(Measured value - nth preceding measured 
value) > Limit where n is specified by 
Previous  

0 ≤  Limit ≤  1273.14 
0 ≤  Previous ≤  10 

Temperature Fall Limit 
(nth preceding measured value - measured 
value) > Limit where n is specified by 
Previous 

0 ≤  Limit ≤  1273.14 
0 ≤  Previous ≤  10 

Temperature Difference 
Limit 

Difference between maximum and minimum 
measured values within section > Limit -273.15 ≤  Limit ≤  99999 

Delayed Temperature High 
Limit 

Measured value > Limit for n successive 
measurements where n is specified by Count 

-273.15 ≤  Limit ≤  99999 
0 ≤  Count ≤  10 

Delayed Temperature Low 
Limit 

Measured value < Limit for n successive 
measurements where n is specified by Count 

-273.15 ≤  Limit ≤  99999 
0 ≤  Count ≤  10 
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Except for the Temperature Difference Limit alarm type, you can select either of the 
following alarm modes for an alarm type:  
- Select Point to report an alarm when any measured value within the section meets 

the alarm condition. 
- Select Average to report an alarm when the average measured value of a section 

meets the alarm condition. 
 
You can click the [Copy] button on the Alarm Setting dialog to copy the detailed alarm 
settings for any alarm No. to another alarm No. 
 

● Temperature Alarm Display 

 
 
When any alarm condition is true, the corresponding alarm button for the channel in the 
Alarm window turns red. Clicking a red Alarm button opens a child window displaying 
information on the alarm section, alarm type and alarm position (Depth) for the detected 
alarm. 
The table below describes what is displayed for the alarm position (Depth) when one or 
more alarms have been detected for a channel. 

Alarm Type Depth 
An average-type alarm has been 
detected. The Start Depth of the alarm section is displayed. 

Both an average-type and a point-
type alarm have been detected. 

Point-type alarms have precedence over average-type alarms. The 
position nearest to the Start Depth of the alarm section is 
displayed. 

A point-type alarm has been 
detected. 

The position nearest to the Start Depth of the alarm section is 
displayed. 
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5.7 Data Compression Using Tag Setting 
 

● Defining Tag Data Conditions 

 
 

You can specify up to 4 sections for tag data compression. 
- Specify the Start Depth and Depth (distance from the Start Depth) for each section. 
- The End Depth is calculated automatically 
- When specifying contiguous sections where the Start Depth of a section coincides 

with the End Depth of the previous section, you can omit the Start Depth. 
 
Each section can be split by specifying a Unit provided that the total number of units in 
all sections does not exceed 100.    
- Configuration is on section basis. The same data type is processed within one 

section. 
- Processing result is generated and retrievable on unit basis. 
- If the Depth of a section is not divisible by the specified Unit, the last section will be 

shorter than a unit. (For example, if Depth=100 [m] and Unit=30 [m], then the 
section will be split into 3 subsections of 30 [m] each and one last subsection of 10 
[m].)   

 
 
 
 
 
 
 
 
 

No1 

Depth 

No2 

Depth[m] 

Start 
Depth End 

Depth 

Depth Start 
Depth 

No3 

End 
Depth 
Start 
Depth 

End 
Depth 

250 200 100 350 450 

Unit×20 Unit×20 Unit×20 
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Any of the following five data types can be selected from the pull-down menu.  
 

Tag Data Type Unit Processing 
Average degC The average value of all measured values within a section is 

determined. 

Maximum degC The maximum value of all measured values within a section is 
determined. 

Minimum degC The minimum value of all measured values within a section is 
determined. 

Difference degC The difference between the maximum and minimum measured values 
within a section is determined. 

Slope degC/m Terms A, B, C, D and E of the least square method are determined. 
 
Compressed tag data can be read via Modbus. 
(Compressed tag data cannot be read using this software.) 

SEE ALSO 
For details, see description on Modbus/RTU and Modbus/TCP in Chapter B5, “Communication 
Functions” of the DTSX200 Guide (IM39J06B45-01E), along with the DTSX200 Communications 
(Modbus) Guide (IM39J06B45-02E). 
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5.8 Self-Test 
The DTSX200 provides a self-test function. 
The Self Test dialog can be displayed by selecting Tool>Self Test in the main window. 

TIP 
- The Self Test dialog can also be displayed by double-clicking the Self Test node in the Solution 

Tree window. 

- Self-test cannot be executed during measurement. 

 

 
 
 
(1) Start button 
Click [Start] to start self test. 
 
(2) Stop button 
Click [Stop] to abort self test. 
 
(3) Close button 
Click [Close] to close the Self Test dialog window. 
 
(4) Result display 
The self-test result display lists each test item along with its completion status 
(Completed or Not yet) and result (OK or NG).  
 
(5) Status display 
The status display shows the status of self-test execution. 

Displayed Status Description 
Stop Self-test not in progress. 
Run Self-test in progress. 
Stop Preparation Preparing to abort self-test. 
Run Preparation Preparing to execute self-test. 

Result display 

Status display 
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6. Monitoring Mode 
 

6.1 Monitoring Mode Functions 
The Monitoring mode is used for checking the measurement status of the DTSX200 and 
measurement results. Monitoring mode does not allow modification of measurement 
parameters of the DTSX200, measurement initiation and measurement termination, and 
thus protects against inadvertent modification during browsing and monitoring. 
 

(1) Setting Measurement Parameters 
Measurement parameters include measurement-related settings and calculation-related 
settings. The former is used for configuring measurement of Raman scatter signal 
levels while the latter is used for configuring temperature data calculation using 
measured signal level data. 
The software supports recalculation of temperature data so any modification to 
calculation-related settings during measurement or after measurement completion is 
reflected in measurement result display. 

TIP 
- Any modification to calculation-related settings during measurement or after measurement 

completion is reflected only in measurement result display but not in saved measurement result 
data. 

- Measurement-related settings are for display only and cannot be modified in Monitoring mode. 

 

(2) Saving Measurement Result Data 

SEE ALSO 
This function is the same as in Control mode. For details, see Section 5.1. 

 

(3) Measurement Result Display 

SEE ALSO 
This function is the same as in Control mode. For details, see Section 5.1. 

 

(4) Status Display 

SEE ALSO 
This function is the same as in Control mode. For details, see Section 5.1. 

 

(5) Enabled and Disabled Functions 
Individual functions of Monitoring mode may be enabled or disabled depending on the 
system status as shown in the table below. 
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Function Window, Dialog or Button 

System Status 

Offlin
e 

state 

Online state 
Connected to DTSX200 Discon

nected 
from 

DTSX2
00 

Measurement 
in progress 

Measurement 
not in 

progress 

Setting 
measurement 
parameters 

Sequence Setting dialog Ο Δ(*1) Δ(*1) Δ(*1) 
Channel Setting dialog (excluding Fiber 
Setting tab) Ο Δ(*1) Δ(*1) Δ(*1) 
Channel Setting dialog (Fiber Setting tab) Ο Δ(*1) Δ(*1) Δ(*1) 

Saving 
measurement 
result 

Trace Storage Config dialog Ο Δ(*1) Ο Δ(*1) 

Measurement 
result display 

Viewer Chart window X Ο X (*3) X (*3) 
Viewer Config dialog Ο Ο Ο Ο 

Status 
display 

Alarm window X Ο Ο X (*3) 
Message window Ο Ο Ο Ο 
Status bar (Measurement status display) X Ο Ο X 
Status bar (Connection status display) Ο Ο Ο Ο 

Self-test 
execution Self Test dialog X X X X 

*1: Display only. No modification is allowed. 
*2: Any modification to settings is reflected in measurement result display but not in saved measurement result data. 
*3: Displays the status at the time of the last measurement. 
Ο: Enabled 
Δ: Enabled but with restrictions 
X: Disabled 
A disabled dialog cannot be displayed. 
A disabled window is displayed but not updated. 
A disabled button cannot be pressed. 
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7. Calibration Mode 
 

7.1 Calibration Mode Functions 
The Calibration mode provides a function for automatic detection of fiber connection 
points, an accessory function for fiber loss correction, and Wizards for temperature 
calibration. In addition, just as in control mode, the Calibration mode allows for setting of 
various measurement parameters of the DTSX200, as well as starting and stopping 
measurement by the DTSX200. 
 

(1) Setting Measurement Parameters 

SEE ALSO 
This function is the same as in Control mode. For details, see Section 5.1. 

 

(2) Starting and Stopping Measurement 

SEE ALSO 
This function is the same as in Control mode. For details, see Section 5.1. 

 

(3) Saving Measurement Result Data 
The software allows trace data (measurement result data) of the DTSX200 to be saved 
on a PC. Data saved to a PC can be retrieved in Trace mode after measurement 
completion. 

TIP 
- Time series data cannot be saved in Calibration mode. 

- Measurement result data can be saved only when the software is connected to the DTSX200. 
Measurement result data cannot be saved when the software is not running or when the software is 
disconnected from the DTSX200 due to communication error or some other reason. 

 

(4) Measurement Result Display 
Measurement result data of the DTSX200 can be displayed as charts. 

TIP 
- Time series charts cannot be displayed in Calibration mode. 

- Multiple charts cannot be displayed side by side in Calibration mode. 

 

(5) Automatic Detection of Connection Points 
Fiber connection points can be detected automatically in Calibration mode. This 
function is useful when multiple fiber segments are spliced together. 
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TIP 
- Connection points may fail to be detected correctly when fiber connection points are close by, 

when reflection is excessive, when connection loss is extremely small or in other cases. If this 
happens, you need to adjust the detected connection points manually.    

 
 

(6) Accessory Function for Fiber Loss Correction 
The Stokes and Anti-Stokes signals of the Raman scatter suffer different fiber loss, 
which may result in temperature measurement error. Fiber loss correction to produce a 
horizontal temperature slope under constant temperature conditions is required. The 
Calibration mode provides a function for displaying an approximate straight line for the 
temperature distribution, which enables accurate and easy adjustment of the correction 
value. 

(7) Status Display 

SEE ALSO 
This function is the same as in Control mode. For details, see Section 5.1. 

 

(8) Self-test 

SEE ALSO 
This function is the same as in Control mode. For details, see Section 5.1. 
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(9) Enabled and Disabled Functions 
Individual functions of Calibration  mode may be enabled or disabled depending on the 
system status as shown in the table below. 

Function Window, Dialog or Button 

System Status 

Offline 
state 

Online state 
Connected to DTSX200 Disconnecte

d from 
DTSX200 Measuremen

t in progress 
Measuremen

t not in 
progress 

Setting 
measurement 
parameters 

Sequence Setting dialog Ο Δ(*1) Ο Δ(*1) 
Channel Setting dialog (excluding 
Fiber Setting tab) Ο Δ(*1) Ο Δ(*1) 

Channel Setting dialog (Fiber Setting 
tab) Ο Δ(*1) Ο(*2) Δ(*1) 

Starting and 
stopping 
measurement 

Start button X X Ο X 

Stop button X Ο X X 

Saving 
measurement 
result 

Trace Storage Config dialog Ο Δ(*1) Ο Δ(*1) 

Measurement 
result display 

Viewer Chart window X Ο X (*3) X (*3) 
Viewer Config dialog Ο Ο Ο Ο 

Automatic 
detection of 
connection 
points 

Fiber Connection Calibration dialog X X Δ(*4) X 

Auxiliary 
function for 
fiber loss 
correction 

Fiber Parameter Calibration dialog X X Δ(*4) X 

Status display 

Alarm window X Ο Ο X (*3) 
Message window Ο Ο Ο Ο 
Status bar (Measurement status 
display) X Ο Ο X 

Status bar (Connection status 
display) Ο Ο Ο Ο 

Self-test 
execution Self Test dialog X X Ο X 
*1: Display only. No modification is allowed.  
*2: Any modification to settings is reflected in measurement result display but not in saved measurement result data. 
*3: Displays the status at the time of the last measurement.  
*4: Enabled when measurement is not in progress and measurement result is displayed as charts. 
Ο: Enabled 
Δ: Enabled but with restrictions 
X: Disabled 
A disabled dialog cannot be displayed. 
A disabled window is displayed but not updated. 
A disabled button cannot be pressed. 
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7.2 Automatic Connection Point Detection 
Temperature calibration is required for each fiber section. The Calibration mode 
provides a function for automatic detection of fiber connection points. The procedure for 
fiber connection point detection is described below. 

 Run the software in calibration mode 
1.  Run the DTSX200 Control Visualization Software in calibration mode. Calibration 

mode provides Wizards for accurate and simple temperature calibration. 

 
 

 Prepare for measurement 
Before running the Wizard for automatic detection of connection points, you need to 
temporarily configure the channel to be calibrated for single-ended measurement. To do 
so, display the Sequence Setting dialog and follow the procedure below: 
2.  Select Single for Sequence Mode on the Sequence Control tab. 
3.  Select the Use checkbox for a row on the Sequence Table tab. 
4.  On the row with the Use checkbox selected: 
- Select SingleEnd for Principle. 
- Select the channel to be calibrated for Channel(Near). 
5.  Click [OK]. The dialog closes. 

Calibration wizards 
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Next, display the Channel_n dialog for the channel to be calibrated (where n denotes its 
channel number) and specify the channel settings as described below. 

 
 
6.  Select a range longer than the total fiber length for Distance Range on the 

Measurement Control tab. 
7.  Select 1m for Sampling Resolution on the Measurement Control tab. 
8.  Click [OK]. The dialog closes. 

 Measurement 
9.  After editing the settings, click the [Start] button on the Toolbar to start 

measurement. 

 Automatic connection point detection 
10. After measurement ends and the measurement result is displayed, double-click on 

Fiber Connection in the Solution Tree window. The Fiber Connection Calibration 
Wizard runs. 

Select Single. 

Select 1m. 

Select an appropriate 
distance range. 

Select Single End. 
Select the channel to be 
calibrated. 
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11. On the displayed dialog, specify whether an optical switch is installed or not by 
selecting or deselecting the With Optical Switch checkbox respectively. 

12. Click [Next] to proceed or click [Cancel] to abort the process. 

 

TIP 
- The [Next] button is enabled only when measurement is not in progress and the measurement 

result is displayed in a chart. 

 
13. If you have clicked the [Next] button in the preceding step, automatic connection 

point detection begins. A CFL (Calculated Fiber Loss) waveform is displayed 
together with the temperature distribution in the chart. A marker is displayed at each 
detected connection point position. A list of the markers is also displayed in the 
Wizard dialog. 

 
 

Specify whether 
an optical switch 
is installed. 

Proceed to next 
step. 

Abort process. 
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TIP 
- The marker list displayed in the Wizard dialog is tied to the markers displayed in the chart. 

- When automatic connection point detection is executed, the chart display switches automatically to 
Distance-Temperature and Distance-CFL.   

- The chart display can be manipulated even when the Wizard dialog is displayed. 

- The CFL waveform is obtained by eliminating the effect of temperature from Stokes signal levels. 
For more details on CFL, see Section 4.7. 

 
The figure and table below describes the functions of the items displayed on the Fiber 
Connection Calibration dialog. 
 

 
 
 

Display Item Description 
Channel number Indicates the number of the channel being calibrated. 

Type 

S denotes the DTSX200 exit position. 
W denotes the switch exit position. 
C01 to C10 denotes a marker connection point. 
E denotes the fiber end position. 
(* Each marker type maps to a marker in the chart display.) 

Term Describes the marker. 

Position Indicates the position of a marker. 
Temperature Indicates the temperature at the marker position. 
Space Indicates the distance of a marker from the preceding marker. 
Slope Indicates the temperature slope between two markers. 
Marker controls Can be used to move, add or delete a marker. 

[OK] button Update Fiber Settings with the fiber connection point information and closes the 
Wizard dialog. 

[Cancel] button Closes the Wizard dialog without updating Fiber Settings with the fiber connection 
point information. 

 

Channel number 

Marker type 

Marker description 
Marker position 

Temperature 

Distance from 
preceding marker 

Temperature slope 

Marker controls 
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TIP 
- If the End Point exceeds the specified distance range, an error provider is displayed at the top left 

corner of the marker list. 

 
 

 Adjust connection points 
You may need to move, delete or add a connection point after automatic connection 
point detection when the position of a detected connection point is off, or a connection 
point is not detected or a detected connection point is not wanted. Markers can be 
moved, added or deleted in Calibration mode.   
 
14. Adjust the connection points as required using the functions for moving, adding and 

deleting a marker. 

TIP 
- Markers can be moved, added or deleted in the Fiber Connection Calibration dialog or the Chart 

window. 
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● Moving a marker 
- To move a marker using the Fiber Connection Calibration dialog: 
(1)  From the marker list, select the marker to be moved. The type of the selected 

marker is displayed in the Type field of the first row in the marker control area. 
(2)  Enter the desired new marker position in the Position field of the first row in the 

marker control area. 
(3)  Click the [Change] button. The marker is moved to the specified position. 

 
 
- To move a marker using Chart window functions: 
(1)  Click on the marker to be moved in the chart display. 
  A yellow band indicating the available range for a new marker position is displayed. 

At the same time, a red broken line appears at the current marker position.   
(2)  Drag and drop the red line to the desired new marker position. The marker is 

moved to the new position.   

 

(1) Select 

(2) Input (3) Click 

Available range 
for new marker 
position 

(1) Click 

(2) Drag & Drop 
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TIP 
- The S marker cannot be moved. 

 

● Adding a marker 
- To add a new marker using the Fiber Connection Calibration dialog: 
(1)  Enter the position for adding a marker in the Position field of the second row in the 

marker control area 
(2)  Click [Add]. A new marker is added at the specified position. 
 
 

 
 
- To add a new marker using Chart window functions: 
(1)  Right-click on the chart display area to display a context menu. 
(2)  Select Marker>Add from the displayed context menu. A yellow band indicating the 

available range for inserting a new marker is displayed.  
(3)  Click on the desired position for adding a new marker on the CFL waveform in the 

chart display. A new marker is displayed at the clicked position.   

 

Available range 
for inserting a 
new marker. 

(1) Input (2) Click 

(2) Click (Select) (1) Right Click 
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Adding a marker 

 

● Deleting a marker 
- To delete a new marker using the Fiber Connection Calibration dialog: 
(1)  From the marker list, select the marker to be deleted. The type and position of the 

selected marker is displayed in the Type and Position fields of the third row in the 
marker control area respectively. 

(2)  Click [Delete]. The selected marker is deleted. 
 

 

(3) Click 

(1) Select 

(2) Click 
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- To delete a marker using Chart window functions: 
(1)  Right-click on the chart display area to display a context menu. 
(2)  Select Marker>Remove>Cnn from the displayed context menu.(nn denotes the type 

of the marker to be deleted.) 
 The specified marker is deleted. 

 
 
Deleting a marker 
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 Update Fiber Settings with connection point information 
15. Finally, click [OK] on the Fiber Connection Calibration dialog. The fiber connection 

point information is updated to the Fiber Setting tab window of the Channel_n 
dialog. Fiber section definition is completed. 
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7.3 Temperature Calibration 
After determining the fiber sections, you need to perform temperature calibration for 
each section. Although temperature calibration can be carried out similarly using 
channel settings, the calibration mode provides an accessory function for fiber loss 
correction and a chart update function to support proper and easy temperature 
calibration.    

 Measurement 
1.  Before executing temperature calibration, you need to execute one measurement 

with temperature calibration disabled. Moreover, the measurement must be 
executed under the same measurement condition (single-ended or double-ended) 
to be calibrated.   

TIP 
- Unlike automatic connection point detection, which requires single-ended measurement to allow 

detection of the fiber end position, temperature calibration requires one measurement executed 
under the actual measurement condition.    

 

 Temperature calibration 
2.  After measurement is completed and the measurement result chart is displayed, 

double-click on Fiber Parameter in the Solution Tree window. The Fiber Parameter 
Calibration Wizard dialog is displayed. 

3.  Clicking [Next] proceeds to the next step; Clicking [Cancel] aborts the process. 

 

TIP 
- The [Next] button is enabled only when measurement is not in progress and the measurement 

result is displayed in a chart. 

 
 

Proceed to the 
next step 

Abort process 
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4.  Click [Next]. The Fiber Parameter Calibration dialog is displayed.  Moreover, an 
approximate straight line (red line) of the temperature distribution is displayed in the 
chart display area. 

 

TIP 
- The chart display switches automatically to Distance-Temperature. 

- The chart display can be manipulated even when the Fiber Parameter Calibration dialog is 
displayed. 

 
The figure and table below describe the functions of the items displayed on the Fiber 
Parameter Calibration dialog. 
 

 
 
 
 

Channel number 

Fiber section 
selection 
[Set] button 

Basic Parameter 
& Correction tab 

Calculate  
Wavenumber tab 

Calibration tab 

[Update Chart] 
button 

[Cancel] button 

[OK] button 
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Display Item Description 
Channel number Displays the number of the channel to be calibrated. 
Section Select a fiber section. 

[Set] button Updates window display with the settings of the selected fiber section.  

Basic Parameter & 
Correction tab 

Select this tab to specify settings for basic parameters and temperature correction 
parameters. 

Calibration tab Select this tab to specify parameters for temperature calibration. 
Calculate 
Wavenumber tab Select this tab to calculate wavenumber. 

[Update Chart] 
button Updates chart display with edited settings. 

[OK] button Updates fiber settings with the specified parameters and closes the dialog. 
[Cancel] button Closes the dialog without updating fiber settings with the specified parameters. 
 

TIP 
- The Length displayed on the Basic Parameter & Correction tab is read-only and cannot be 

modified. 
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● Fiber loss correction 
The DTSX200 calculates temperature using the Stokes and Anti-stokes signal level 
ratio. This introduces a temperature error due to the difference in fiber transmission loss 
between the two signals. To correct this temperature error, you need to adjust the Loss 
value displayed on the Basic Parameter & Correction tab. The Loss here refers to the 
differential fiber transmission loss per unit length between the Stokes light and Anti-
Stokes light. The Loss parameter has unit dB/km and is related to the temperature 
slope. The procedure for fiber loss correction is described below.     
 
1.  Select the fiber section to be calibrated from the pull-down menu of the Section field 

on the Fiber Parameter Calibration dialog and click the [Set] button. 

 
An approximate straight line for the temperature distribution of the selected fiber section 
is displayed. 

 
 
2.  Modify the Loss value and click [Update Chart]. The temperature distribution and 

approximate straight line display is updated using the new Loss value. Repeat this 
step until the desired temperature slope is achieved. 

3.  Repeat steps 1. to 2. for each fiber section. 
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TIP 
- If double-ended measurement, the measurement results in the forward direction and reverse 

direction are combined . This offsets any differential loss so loss correction is not required for 
double-ended measurement. 

- In a constant temperature environment such as a constant temperature reservoir, adjust the Loss 
value until the temperature slope of the approximate straight line is horizontal. 

Example: Horizontal temperature slope achieved through loss adjustment 

 
- If each fiber section is installed with two thermometers at two different positions, you can also 

adjust fiber loss using real thermometer temperature readings by modifying the Loss value to make 
the displayed temperature slope coincide with the temperature slope between the two thermometer 
readings. 

 

● Temperature Calibration 
Temperature values depend on the wavenumber (unit: cm-1). The wavenumber 
parameter is related to the temperature scale factor. To determine the real wavenumber, 
thermometer readings and DTS readings (measured temperature values) at two 
different positions are required.     

TIP 
- We recommend to maximize the temperature difference between the two positions for better 

temperature calibration. 

- Fiber loss correction must be done correctly for the distance between two different positions. 
Moreover, no fiber connection point must be present between the two different positions. 

- Wavenumber can also be calculated using measured data values for two different temperatures at 
the same position. 
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The procedure for temperature calibration is given below. First, configure the software to 
calculate the real wavenumber. 
 
1.  Select the Calculate Wavenumber tab. 
2.  Enter the thermometer reading and DTSX200 reading for a normal temperature 

value (low temperature) in the Normal Temperature section. Next, enter the 
thermometer reading and DTSX200 reading for a high temperature value in the 
Heated Temperature  section. 

3.  Click [Calculate] . The wavenumber is calculated and updated to Wavenumber of 
the Calculation Result group box. 

4.  Click [Copy]. The calculated result is updated to Setting of the Wavenumber group 
box on the Calibration tab. 

 

  
 
 
5.  To enable the wavenumber, select the Use checkbox on the Calibration tab window 

and select the Setting option for Wavenumber. 

Update calculated wavenumber to 
Wavenumber on Calibration tab 

Thermometer reading for normal 
temperature (low temperature) 

DTSX200 reading for normal 
temperature (low temperature)  
(* Measured value before calibration) 
 Thermometer reading for high 
temperature 
 

Calculate wavenumber 

Calculated wavenumber 

Click [Copy] 

DTSX200 reading for high 
temperature  
(* Measured value before calibration) 
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Display Item Function 
Use flag Select this checkbox to enable temperature calibration. 
Calibration  
Type Select the Calibration type. 

 

Manual Input Select this option to enable the Manual Input group box 
and use its settings for calibration. 

Remote Input Select this option to enable the Remote Input group box 
and use its settings for calibration. 

Optical Switch 

Select this option to use settings stored in the optical 
switch memory for calibration.  
* This option can only be selected for the first fiber 
section. 
* If this option is selected but no optical switch is 
installed, temperature calibration is not performed. 

Wavenumber This group box selects and defines the wavenumber to 
be used for temperature calculation. 

 
Default or Other Section 

Select this option to use the default wavenumber value 
or the wavenumber value specified for other fiber 
sections. 
* If wavenumber is specified for multiple fiber sections, 
their average value is used. 

Setting Select this option to use the specified wavenumber 
value. 

Remote Input Select this option to calibrate DTSX200 temperature 
measurement using data at a specified position. 

 
Position Specify the position for temperature calibration. 

Averaging Distance Specify the distance in meters centered at the specified 
position to be used for averaging. 

Manual Input 
Select this option to calibrate DTSX200 temperature 
measurement using an actual thermometer temperature 
reading (temperature offset calibration). 

 
Thermometer Reading Specify the thermometer temperature reading (actual 

value). 

DTS Reading Specify the DTSX200 temperature measurement 
reading. 

 

Use flag 

Remote Input 

Manual Input 

Calibration 
Type 

Wavenumber 
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Next, perform temperature offset correction. Fiber connection loss occurs at the optical 
switch and fiber connection points. Connection loss also differs between Stokes light 
and Anti-Stokes light so it is necessary to perform temperature offset correction for each 
fiber section.    
 
6.  Select Manual Input, Remote Input or Optical Switch for Calibration Type. (* If 

Manual Input is selected, the Manual Input group box is enabled. If Remote Input is 
selected, the Remote Input group box is enabled. If Optical Switch is selected, both 
the Manual Input and Remote Input group boxes are disabled.) 

7.  If Manual Input is selected, specify a thermometer reading and a DTSX200 reading. 
The DTSX200 reading is calibrated using the thermometer reading as the true 
value. If Remote Input is selected, enter values for Position and Averaging 
Distance. DTSX200 temperature measurement will be calibrated using 
thermometer readings and DTSX200 readings at the specified position. If Optical 
Switch is selected, settings stored in the optical switch memory are used for 
calibration. The Optical Switch option, however, can only be selected for the first 
fiber section. 

8.  Click [Update Chart]. Temperature calibration is executed and the result updated in 
the chart display. 

9.  Next, perform temperature calibration similarly for the other sections. However, if 
fibers from the same lot are used, the wavenumber value is normally similar so 
once you have specified the wavenumber for one fiber section, you can select the 
Default or Other Section option for the other sections. 

TIP 
- DTSX200 measured temperature values used for temperature calibration must be pre-calibration 

values. 

 

● Temperature Correction 
Although we recommend performing fiber loss correction and temperature calibration 
using the procedures described earlier, you can also perform simple temperature 
correction using the Correction function. 

 
Display Function 

Use Select this checkbox to enable temperature correction. 
Linearity This parameter relates to the temperature scale. 

Slope This parameter relates to the temperature slope. 
(* It represents the temperature change [degC] per 100 meters.) 

Offset This parameter relates to the temperature offset. 
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 Updating to Fiber Settings 
After completing temperature calibration, click the [OK] button on the Fiber Parameter 
Calibration dialog. The calibrated settings are updated to the Fiber Setting dialog. The 
calibrated settings can now be used to perform measurement in calibration mode. 
Moreover, the calibrated settings, once saved, can also be loaded and used in control 
mode. 
 

 
 

Basic Parameter & Correction tab of the Fiber Parameter Calibration dialog 

 

Fiber Setting_nn dialog (where nn denotes a fiber section number) 

 

Calibration tab of the Fiber Parameter Calibration dialog 
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8. Trace Mode 
 

8.1 Trace Mode Functions 
The Trace mode is used for checking measurement results after measurement 
completion. 

TIP 
The following terms will be used hereafter: 

- Trace data refers to measurement result data. 

- Trace file refers to a file containing trace data. 

- Trace folder refers to a folder storing trace files. 

- For information on the trace file and folder structure, see Section 5.2. 

 

(1) Loading Measurement Results 
You can specify a trace folder or a trace file to be loaded. 
- Specifying a trace folder for loading 

 You can specify a trace folder to load all trace files below the folder in one go 
and then specify the location of the trace file to be displayed when displaying 
measurement results.  

 If a time series data file is present, time series data is also loaded so time 
series chart display can be selected in measurement result display. 

- Specifying a trace folder for loading 
 If you specify a trace file for loading, only the specified trace file is loaded.  
 Time series chart display cannot be selected in measurement result display. 

(2) Setting Measurement Parameters 
Measurement parameters include measurement-related settings and calculation-related 
settings. The former is used for configuring measurement of Raman scatter signal 
levels while the latter is used for configuring temperature data calculation using 
measured signal level data. 
The software supports recalculation of temperature data so any modification to 
calculation-related settings is reflected in measurement result display. 

TIP 
- Any modification to calculation-related settings is reflected only in measurement result display but 

not in trace folders or trace files. 

- Measurement-related settings are for display only and cannot be modified in trace mode. 

 

(3) Measurement Result Display 
Loaded trace data can be displayed as charts. 
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(4) Status Display 
Status display functions include DTSX200 status display and software status display. 
• DTSX200 status display 
- Alarm window: 

 Displays status information on temperature alarms detected by the DTSX200 
for the displayed trace data. (If multiple data sets are displayed in the 
measurement result display, the alarm status of the oldest data set is 
displayed.) 

• Software status display 
- Message window: 

 Displays various errors and warnings detected by the software. 

(5) Saving Measurement Result to CSV Format File 
Loaded trace data can be converted and saved to a CSV formatted file. 
The created CSV file, however, cannot be reloaded by the software. 

(6) Enabled and Disabled Functions 
The table below shows enabled and disabled functions in trace mode. 

Function Window, Dialog or Button 
Status 

Offline state 

Setting measurement 
parameters 

Sequence Setting dialog Δ(*1) 
Channel Setting dialog (excluding Fiber Setting tab) Δ(*1) 
Channel Setting dialog (Fiber Setting tab) Ο (*2) 

Saving measurement 
result Trace Storage Config dialog Δ(*1) 

Measurement result 
display 

Viewer Chart window Ο 
Viewer Config dialog Ο 

Status display Alarm window Ο(*3) 
Message window Ο 

*1: Display only. No modification is allowed. 
*2: Any modification to settings is reflected in measurement result display but not in measurement result file. 
*3: Displays the status for the displayed measurement result data. 
Ο: Enabled 
Δ: Enabled but with restrictions 
X: Disabled 
A disabled dialog cannot be displayed. 
A disabled window is displayed but not updated. 
A disabled button cannot be pressed. 
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8.2 Loading Trace Folder or Trace File 
Run the software and select Trace on the Select Mode dialog. The Open Trace dialog is 
displayed. 

 
Select whether to load a trace folder or a trace file, and then specify a folder name or 
file name to be loaded. 
 
1.  Select Folder or File. 
2.  If you have selected Folder, you can specify the folder to be loaded by: 
- Entering a folder name directly; or 
- Clicking the [Browse] button and selecting a folder on the displayed Browse For 

Folder dialog. 
3.  If you have selected File, you can specify the file to be loaded by: 
- Entering a file name directly; or 
- Clicking the [Browse] button and selecting a file on the displayed “Open a trace file” 

dialog. 
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The table below shows a sample trace folder/file structure. 
Folder Structure Description 

C:\Trace Destination for storing trace folder specified in Save Folder 
 120110722173446  Trace folder (created at the beginning of each measurement) 
  0   Trace file folder 0 
  1   Trace file folder 1 
  2   Trace file folder 2 
 120110726101750  Trace folder (created at the beginning of each measurement) 
  0   Trace file folder 0 
 220110723181227  Trace folder (created at the beginning of each measurement) 
  0   Trace file folder 0 
 320110718105637  Trace folder (created at the beginning of each measurement) 
  0   Trace file folder 0 
  1   Trace file folder 1 

File Structure Description 
 120110722173446  Trace folder (created at the beginning of each measurement) 
  UserSetup.dsu   Configuration file 
  InternalSetup.dsi   Configuration file 
  InitialInfo.ddi   Configuration file 
  TraceTimeseries0.ddr   Time series data file (for optical switch channel 1) 
  TraceTimeseries1.ddr   Time series data file (for optical switch channel 2) 
  0   Trace file folder 0 
   t20110726101813c01.ddt    Trace file (measurement result file) 
   t20110726101818c02.ddt    Trace file (measurement result file) 
   t20110726101828c01.ddt    Trace file (measurement result file) 
   t20110726101834c02.ddt    Trace file (measurement result file) 
   t20110726101845c01.ddt    Trace file (measurement result file) 
   t20110726101852c02.ddt    Trace file (measurement result file) 

Bolded text indicates a folder name. 
Shaded text indicates a file name. 
Underlined text indicates a trace folder name which can be specified for loading in Trace mode. 
Italicized text indicates a trace file name which can be specified for loading in Trace mode. 
 
 

 IMPORTANT 
 

- When specifying a trace folder or trace file to be loaded, you must select one of the 
loadable locations shown in the above table. Otherwise, loading may fail or an error 
may occur after loading. 

- Do not change the structure or names of subfolders and files below a trace folder. 
Otherwise, data loading by the software may fail or an error may occur after 
loading. 

- Always specify a trace folder when copying or deleting trace data. Loading by the 
software will fail if only subfolders or files under a trace folder are copied. 

- Do not modify the content of configuration files, time series data files and trace files. 
Otherwise, data loading by the software may fail or an error may occur after 
loading. 
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8.3 Saving to CSV File 
Trace data can be converted to CSV format and saved in a file using the CSV Save 
Config dialog. 

 
 
On the CSV Save Config dialog, specify a destination folder for saving CSV files, the 
data types to be converted, the temperature unit, the distance unit, the trace files to be 
converted and whether to overwrite an existing file having the same name during 
saving. Click the [RUN] button to begin CSV file conversion. 
 
1.  In the Save Folder (CSV File) field, specify a folder for storing converted CSV files. 

An error will be reported if the specified folder does not exist. 
2.  In the Data Type group box, specify the data to be converted as follows: 
- To output distance parameters, select the Index checkbox. 
- If you have selected the Index checkbox, select Depth or Distance. 
- Select one or more of the Temperature, Signal level (ST), Signal level (AS) and CFL 

checkboxes as data types to be output. Conversion is not allowed if none of these 
four checkboxes are selected. 

3.  Specify the temperature unit for the output data by selecting Celsius[degC], 
Fahrenheit[degF] or Kelvin[K] for Temperature Unit. This setting applies to the 
Temperature data type. 



 <8. Trace Mode > 156 
 

  IM 39J02B45-01E 
  

4.  Specify the depth/distance unit for output data by selecting Meter[m], Yard[yd] or 
Feet[ft] for Depth/Distance Unit. This setting applies to the Depth and Distance data 
types. 

5.  Under File Control, specify the trace files to be converted as follows: 
- From the Trace Files list displayed on the left, select a file to be converted and click 

the [->] button. The selected file is added to the CSV Files list on the right. 
- To remove a file from the CSV Files list of files to be converted, select the file and 

click the [<-] button. 
- By selecting or deselecting the Overwrite An Existing File checkbox, specify 

whether to overwrite an existing file in the specified destination folder having the 
same file name as a CSV file to be saved, if found. 

6.  Click the [RUN] button to initiate CSV file conversion. The following Convert CSV 
Files dialog is displayed to show the execution progress. 

 

 
 
7.  When CSV file conversion is completed, the Convert CSV Files dialog closes 

automatically. 
8.  Clicking the [Cancel] button during conversion aborts the conversion and closes the 

dialog. 

TIP 
- A converted CSV file has the same name as the original trace file but with file extension “.csv”.  

Example:  

 Trace file name: t20110126032134c01.ddt 

 Display in Trace Files list: Ch:01/Time:2011/01/26 03:21:34 

 CSV file name: t20110126032134c01.csv 

- Converted CSV files cannot be loaded using this software. 

- If CSV file conversion is aborted, CSV files created before the abort will remain undeleted in the 
destination folder. 
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Appendix A. Messages 
A specific message may be displayed only in the Message window (see Section 
4.8), only in dialogs or both. In addition, messages can be broadly classified into 
the following types. 

Type Description 
Normal Normal information 
Error An error has been detected (but the application can continue execution.) 
FatalError An error has been detected (and the application cannot continue execution.) 
Warning A warning has been detected (but the application can continue execution.) 
Terminated The application is terminated. 
 

 IMPORTANT 
 

- If an Error type message is displayed, the application can continue execution but 
there may be some limitations on its operation thereafter. 

- If a FatalError type message is displayed, it will be followed by a “Terminated” type 
message and the application will be aborted. 
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Appendix  A.1 List of Messages 
● Normal messages 

List of Normal Messages 
No. Type Message Description Remedial Measures 

0651 Normal Cannot change setting, 
now! Please save. 

A setting could not be 
changed. Settings cannot be 
changed during measurement 
in online state when in 
disconnected state.  

- To keep current settings, 
save and then load the 
settings.  

0652 Normal Please define a 
"Sequence Table". 

Measurement could not be 
started because sequence 
settings have not been 
defined.  

- Define sequence settings. 
- See Section 5.3, “Single-

ended Measurement” or 
Section 5.4, “Double-ended 
Measurement” for details.  

0653 Normal Setting isn't transmitted 
to DTS. Please save. 

Measurement is not started 
after settings are modified so 
current settings are not 
updated to the DTSX200 and 
may be overwritten by old 
settings on the DTSX200 on 
subsequent connection to the 
DTSX200. Save the modified 
settings if necessary. 

- To keep current settings, 
save the settings.  

0713 Normal Start Connect, 
Reconnection was initiated 
because an error was detected 
during communication with the 
DTSX200.  

- Check the error reported in 
the preceding message for 
the cause of reconnection.  

0714 Normal Cancel Connect Connection with the DTSX200 
was cancelled by a user. -  

0717 Normal DTS was rebooted. It is 
reconnected. 

Reconnection is made to the 
DTSX200 because the 
DTSX200 was rebooted. 

- Check the DTSX200 
message log for the cause 
of reboot. 

0719 Normal Connect to DTS. Connection was made to 
DTSX200.  

0729 Normal 
Connection with DTS 
went wrong. Click the 
Connect button and 
connect again. 

Connection to DTSX200 has 
failed. Click the [Connect] 
button to connect again. 

- Click the [Connect] button 
to connect again. 
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● Warning messages 

List of Warning Messages 
No. Type Message Description Remedial Measures 

0102 Warning The specified folder is 
not found. 

The folder specified for Save 
Folder in the CSV Save Config 
dialog was not found. 

- Check that the specified 
folder exists. 

The folder specified for Save 
Folder in the Trace Storage 
Config dialog was not found. 

- Check that the specified 
folder exists. 

The folder specified for Open 
Folder Or File in the Open 
Trace dialog was not found. 

- Check that the specified 
folder exists. 

0103 Warning There is no item in the 
conversion list. 

No item for conversion has 
been added to CSV Files in the 
CSV Save Config dialog. 

- Add at least one item to 
CSV Files and re-execute 
CSV conversion. 

0104 Warning The selection channel 
overlaps. 

A channel is selected more 
than once in the Sequence 
Table of the Sequence Setting 
dialog. 

- Modify the Sequence Table 
settings to remove the 
duplicate channel selection. 

0105 Warning No measurement 
channel is specified. 

No channel for measurement 
is specified in the Sequence 
Table of the Sequence Setting 
dialog. 

- Specify at least one 
channel for measurement 
in the Sequence Table. 

0106 Warning No data type is selected. 
No data type for conversion is 
selected for Data Type in the 
CSV Save Config dialog. 

- Select at least one data 
type for conversion in Data 
Type and then execute 
CSV conversion again. 

0205 Warning 
Trace Warning (Time 
series data file does not 
exist.) 

In trace mode, time series data 
was not found in the specified 
trace folder. Chart display with 
time on the X axis is not 
allowed. 

- This message is displayed 
if time series data was not 
saved at the time of 
measurement. 

0208 Warning 
Trace Warning (Failed to 
save file because a file of 
the same name exists.) 

In trace mode, a converted 
CSV file could not be saved 
because a file of the same 
name was found. 

- This message is displayed 
only if the option to 
overwrite an existing file is 
not selected. 

0727 Warning Some functions are 
unavailable for the 
connected DTS. 

Some functions are 
unavailable as either the 
DTSX200 firmware or the 
DTAP200 software is not of the 
latest version. 

Upgrade the firmware of the 
DTSX200, as well as the 
DTAP200 software, to the 
latest version. 

 
 
 



 <Appendix A. Messages > 160 
 

  IM 39J02B45-01E 
  

● Error messages 

List of Error Messages 
No. Type Message Description Remedial Measures 

0201 Error Trace Error (Failed to 
load setting file.) 

When in control, monitor or 
calibration mode, a settings file 
downloaded by DTSX200 
could not be loaded. 

- Check that no modification 
has been made to the file 
structure, folder structure or 
files in the trace folder. 

- Reboot the PC and re-
execute measurement. 

- Reboot the DTSX200 and 
re-execute measurement. 

- Change the trace folder 
and re-execute 
measurement. 

When in trace mode, 
either the file structure of the 
specified trace folder is invalid 
or the content of a settings file 
is invalid. 

- Check that no modification 
has been made to the file 
structure, folder structure or 
files in the trace folder. 

- Re-execute measurement 
and then load the acquired 
trace folder or file.  

0202 Error Trace Error (Failed to 
save csv file.) 

In trace mode, a converted 
CSV file could not be saved. 

- Check that no modification 
has been made to the file 
structure, folder structure or 
files in the trace folder. 

- Check that the destination 
folder for CSV files has 
sufficient free space.  

- Check that the destination 
folder for CSV files exists. 

- Change the destination 
folder for saving CSV files. 

0203 Error Trace Error (Failed to 
load data file.) 

When in control, monitor or 
calibration mode, a trace file 
downloaded by DTSX200 
could not be loaded. 

- Check that no modification 
has been made to the file 
structure, folder structure or 
files in the trace folder. 

- Reboot the PC and re-
execute measurement. 

- Reboot the DTSX200 and 
re-execute measurement. 

- Change the trace folder 
and re-execute 
measurement. 

When in trace mode, either the 
file structure of the specified 
trace folder is invalid or the 
content of a trace file is invalid. 

- Check that no modification 
has been made to the file 
structure, folder structure or 
files in the trace folder. 

- Re-execute measurement 
and then load the acquired 
trace folder or file. 

0204 Error Trace Error (File or folder 
does not exist.) 

When in trace mode, the 
specified trace folder or trace 
file was not found.  

- Check that no modification 
has been made to the file 
structure, folder structure or 
files in the trace folder. 

- Check that the specified file 
or folder exists. 

0206 Error Trace Error (Failed to 
save timeseries file.) 

When in control or monitoring 
mode, time series data files 
could not be saved at the end 
of measurement.  

- Check that no modification 
has been made to the file 
structure, folder structure or 
files in the trace folder. 
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No. Type Message Description Remedial Measures 
If time series data is 
discontinuous because 
measurement by the DTSX200 
is momentarily interrupted or 
trace file retrieval is 
discontinuous because the 
communication between this 
software and the DTSX200 is 
disconnected, only time series 
data preceding the 
discontinuity is stored. 

- Reboot the PC and re-
execute measurement. 

- Change the trace folder 
and re-execute 
measurement. 

0207 Error 
Trace Error (Failed to 
open measurement 
database.) 

When in control, monitor or 
calibration mode, the specified 
trace folder was not found.  

- Check that no modification 
has been made to the file 
structure, folder structure or 
files in the trace folder. 

- Reboot the PC and re-
execute measurement.  

- Change the trace folder 
and re-execute 
measurement. 

When in trace mode, the 
specified trace folder or trace 
file was not found.  

- Check that no modification 
has been made to the file 
structure, folder structure or 
files in the trace folder. 

- Check that the specified file 
or folder exists. 

0209 Error Trace Error (Failed to 
save setting file.) 

When in control, monitor or 
calibration mode, settings files 
could not be saved at the 
beginning of measurement. 

- Check that no modification 
has been made to the file 
structure, folder structure or 
files in the trace folder. 

- Reboot the PC and re-
execute measurement. 

- Change the trace folder 
and re-execute 
measurement. 

0210 Error Trace Error (trace display 
overrun) 

Update processing of chart 
display failed to keep up. 

- Try terminating other 
applications running on the 
PC. 

- The processing power of 
the PC may be inadequate. 
Try switching to a more 
powerful PC. 

0501 Error Setup Error (Failed to 
load a setting.) 

The specified settings file 
could not be loaded. 

- Check that the file exists. 
- Check that software startup 

or exit is not in progress. 
- Check that measurement 

by DTSX200 is not in 
progress. 

- Save settings and check if 
the file can be loaded.  

0502 Error Setup Error (Failed to 
save a setting.) 

The specified settings file 
could not be saved. 

- Check that the file exists. 
- Check that software startup 

or exit is not in progress. 

0503 Error Setup Error (Failed to 
default a setting.) 

The specified setting could not 
be initialized. 

- Check that software startup 
or exit is not in progress. 

- Check that measurement 
by DTSX200 is not in 
progress. 

0504 Error Setup Error (Failed to 
copy a setting.) 

The specified setting could not 
be copied. 

- Check that software startup 
or exit is not in progress. 

0505 Error Setup Error (Failed to 
paste a setting) 

The specified setting could not 
be pasted. 

- Check that software startup 
or exit is not in progress. 

- Check that measurement 
by DTSX200 is not in 
progress. 

- Copy setting and check if 
the setting can be pasted. 

0506 Error Setup Error (Failed to 
change a setting.) 

The specified setting could not 
be changed. 

- Check that software startup 
or exit is not in progress. 

- Check that measurement 
by DTSX200 is not in 
progress. 
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No. Type Message Description Remedial Measures 

0509 Error Startup Error (Failed to 
get data from form.) 

Setting(s) could not be 
retrieved from a displayed 
configuration dialog. 

- Try re-running the software. 
- Try rebooting the PC. 
- Try reinstalling the 

software. 

0511 Error Form Error (Failed to 
open a form.) 

A window or dialog could not 
be displayed. 

- Try re-running the software. 
- Try rebooting the PC. 
- Try reinstalling the 

software. 

0514 Error Form Error (Failed to 
close a form.) 

An error was detected during 
termination of a dialog. 

- Try re-running the software. 
- Try rebooting the PC. 
- Try reinstalling the 

software. 

0515 Error Form Error (Failed to 
make a dialog) A dialog could not be created. 

- Try re-running the software. 
- Try rebooting the PC. 
- Try reinstalling the 

software. 

0523 Error Processing Error (Cannot 
connect to DTS.) 

Connection to DTSX200 was 
aborted. 

- Check that the DTSX200 is 
not connected. 

- The status display may be 
delayed. 

0524 Error Processing Error (Cannot 
start measurement.) 

Measurement could not be 
started. 

- Check that measurement is 
not already started. 

- Check that self test is not in 
progress. 

- Check that the DTSX200 is 
not disconnected. 

- The status display may be 
delayed. 

0525 Error Processing Error (Cannot 
stop measurement.) 

Measurement could not be 
stopped. 

- Check that measurement is 
not already stopped. 

- Check that self test is not in 
progress. 

- Check that the DTSX200 is 
not disconnected. 

- The status display may be 
delayed. 

0531 Error File Error (Failed to find a 
file.) 

A file (manual, etc.) does not 
exist. 

- Try reinstalling the 
software. 

0532 Error File Error (Failed to open 
a file.) 

A file (manual, etc.) could not 
be opened. 

- Install Acrobat Reader or 
some other PDF file 
browser software. 

0543 Error Calibration Error (Cannot 
calibrate) 

Calibration could not be 
executed. 

- Check that DTSX200 has 
stopped measurement.  

- Check that self test is not in 
progress. 

- Check that the DTSX200 is 
not disconnected. 

- The status display may be 
delayed. 

0554 Error Setup Error (Value is 
empty.) No value is specified. 

- Specify a value. 
- See parameter description 

in this manual for details. 

0555 Error Setup Error (Over max 
length.) 

The specified character string 
is too long. 

- Specify a string value not 
longer than the length limit. 

- See parameter description 
in this manual for details. 

0557 Error Setup Error (Over max 
value.) 

The specified value is too 
large. 

- Specify a value equal or 
smaller than the high limit. 

- See parameter description 
in this manual for details. 

0558 Error Setup Error (Under min 
value.) 

The specified value is too 
small. 

- Specify a value equal or 
larger than the low limit. 

- See parameter description 
in the manual for details. 

0559 Error 
Setup Error (Illegal 
preceding or trailing 
space characters.) 

Space character(s) are present 
at the beginning and/or end of 
the specified value. 

- Remove preceding and 
trailing space character(s) 
from the specified value. 

- See parameter description 
in this manual for details. 

0560 Error Setup Error (Invalid 
Value) 

The specified value is invalid. 
(E.g. A letter was wrongly 

- Specify a valid value.  
- See parameter description 



 <Appendix A. Messages > 163 
 

  IM 39J02B45-01E 
  

No. Type Message Description Remedial Measures 
entered for a numeric 
parameter.) 

in this manual for details. 

0701 Error Comm Error 

This is a general 
communication error. The 
application will automatically 
retry to communicate with the 
DTSX200. If the failure 
persists, adopt the remedial 
measures.   

- Try rebooting the PC. 
- Try rebooting the 

DTSX200. 
- Check the transmission 

path between the PC and 
DTSX200. 

0702 Error SFTP Connect Error SFTP connection has failed. 

- Try rebooting the PC. 
- Try rebooting the 

DTSX200. 
- Check the transmission 

path between the PC and 
DTSX200. 

0703 Error SFTP Login Error SFTP login has failed. 

- Try rebooting the PC. 
- Try rebooting the 

DTSX200. 
- Check the transmission 

path between the PC and 
DTSX200. 

0704 Error SCP Connect Error SCP connection has failed. 

- Try rebooting the PC. 
- Try rebooting the 

DTSX200. 
- Check the transmission 

path between the PC and 
DTSX200. 

0705 Error SCP Login Error SCP login has failed. 

- Try rebooting the PC. 
- Try rebooting the 

DTSX200. 
- Check the transmission 

path between the PC and 
DTSX200. 

0706 Error DTS Connect Error (IP 
Address Error.) 

DTSX200 was not found at the 
specified IP address. 

- Check the IP address of the 
DTSX200. 

- Check that DTSX200 is 
powered on. 

- Check the transmission 
path to the DTSX200. 

- Try rebooting the PC. 
- Try rebooting the 

DTSX200. 

0707 Error SSH Connect Error SSH connection has failed. 

- Try rebooting the PC. 
- Try rebooting the 

DTSX200. 
- Check the transmission 

path between the PC and 
DTSX200. 

0708 Error SSH Login Error SSH login has failed. 

- Check the user ID and 
password. 

- Try rebooting the PC. 
- Try rebooting the 

DTSX200. 
- Check the transmission 

path between the PC and 
DTSX200. 

0709 Error Measurement Error 
An error was detected during 
measurement preparation or 
during measurement.   

- Check that the DTSX200 is 
not performing self-test. 

- Try rebooting the PC. 
- Try rebooting the 

DTSX200. 
- Check the transmission 

path between the PC and 
DTSX200. 

0710 Error Selftest Error 
An error was detected during 
self-test preparation or during 
self-test execution. 

- Check that the DTSX200 is 
not performing 
measurement.  

- Try rebooting the PC. 
- Try rebooting the 

DTSX200. 
- Check the transmission 

path between the PC and 
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No. Type Message Description Remedial Measures 
DTSX200. 

0715 Error 

DTS Connect Error (The 
number of DTS 
connections exceeded 
limit or port numbers are 
different.) 

The number of DTSX200 
connections exceeded the 
maximum limit or port numbers 
are different. 

- Check the DTSX200 port 
number.  

- Reduce the number of 
connections to the 
DTSX200 from this 
software or from data 
conversion software.  

- Check the transmission 
path to the DTSX200. 

- Try rebooting the PC. 
- Try rebooting the 

DTSX200. 

0716 Error Disk Full. 
The free space on the 
specified storage device is 
below the stipulated value. 

- Change to a storage device 
with sufficient free space 
for saving trace files. 

- Try rebooting the PC. 

0718 Error DTS Status Error DTSX200 initialization is taking 
too long. 

- Try rebooting the 
DTSX200. 

- Check the transmission 
path between the PC and 
DTSX200. 

0725 Error DTS Connect Error (The 
port number is different.) 

Connection to DTSX200 has 
failed because port numbers 
are different. 

- Check the port number of 
the DTSX200. 

- Check the transmission 
path to the DTSX200. 

- Try rebooting the PC. 
- Try rebooting the 

DTSX200. 

0726 Error Connection to this DTS is 
not allowed. 

This application version does 
not allow connection to the 
DTSX200. 

- Try upgrading this software 
and the DTSX200 system 
to the latest version. 

- Try rebooting the PC. 
- Try rebooting the 

DTSX200. 

0728 Error DTS Connect Error (IP 
Address Error.) 

DTSX200 was not found at the 
specified IP address. 

- Check the IP address of the 
DTSX200 

- Check that the DTSX200 is 
powered on.  

- Check the transmission 
path to the DTSX200. 

- Try rebooting the PC. 
- Try rebooting the 

DTSX200. 

0730 Error 
User ID authority is not 
RW User. Please re-
connect with a different 
user name. 

The login user ID does not 
have RW authority. 

- Check the authority of the 
login user name.  

- Try rebooting the 
DTSX200. 

0731 Error Please perform 
installation from a disk. 

You should re-install the 
application from the installation 
disk. 

- Reinstall the application. 
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● Fatal Error messages 

List of Fatal Error Messages 
No. Type Message Description Remedial Measures 

0001 FatalError Startup Error (Failed to 
copy folder(s).) 

The startup process has failed 
to copy a work folder. 

- Try rebooting the PC. 
- Try reinstalling the 

software. 
- Try replacing the PC. 

0002 FatalError Startup Error (Failed to 
read a configuration File.) 

The startup process has failed 
to load the default 
configuration file. 

- Try rebooting the PC. 
- Try reinstalling the 

software. 
- Try replacing the PC. 

0003 FatalError Exit Error (Failed to copy 
or delete folder(s).) 

A work folder could not be 
copied or deleted at software 
termination. 

- Try rebooting the PC. 
- Try reinstalling the 

software. 
- Try replacing the PC. 

0004 FatalError Startup Error (Failed to 
get an application folder.) 

The startup process has failed 
to get the folder name 
containing this software. 

- Try rebooting the PC. 
- Try reinstalling the 

software. 
- Try replacing the PC. 

0005 FatalError 
Startup Error (Failed to 
get an application launch 
ID.) 

The startup process has failed 
to get an application launch ID.  

- Try rebooting the PC. 
- Try reinstalling the 

software. 
- Try replacing the PC. 

0006 FatalError Startup Error (Failed to 
make folder(s).) 

The startup process has failed 
to create one or more work 
folders. 

- Try rebooting the PC. 
- Try reinstalling the 

software. 
- Try replacing the PC. 

0007 FatalError 
Startup Error (Failed to 
get a MyDocuments 
folder.) 

The startup process has failed 
to get a MyDocuments folder. 

- Try rebooting the PC. 
- Try reinstalling the 

software. 
- Try replacing the PC. 

0008 FatalError 
Startup Error (Failed to 
get an application work 
folder.) 

The startup process has failed 
to get an application folder. 

- Try rebooting the PC. 
- Try reinstalling the 

software. 
- Try replacing the PC. 

0009 FatalError 

Startup Error (Failed to 
start a application. You 
can use 8 applications at 
the same time.) 

The application could not be 
started because the limit on 
the number of DTSX200-
related applications (DTAP200, 
DTAP200D and DTAP200LAS) 
running concurrently was 
exceeded. 

- Check that no more than 7 
instances of the DTSX200-
related applications are 
running concurrently. 

- Try rebooting the PC. 

0010 FatalError Startup Error (Failed to 
get a trace folder.) 

The specified trace folder or 
default trace folder was not 
found. 

- Try rebooting the PC. 
- Try reinstalling the 

software. 
- Try replacing the PC. 

0101 FatalError Temperature Calculation 
Error 

Temperature calculation has 
failed. 

- Try rebooting the PC. 
- Try rebooting the 

DTSX200. 

0591 FatalError Fatal Error A non-recoverable software 
error has been detected. 

- Try re-running the software. 
- Try rebooting the PC. 
- Try reinstalling the 

software. 
- Try replacing the PC. 

 
 

● Termination messages 

List of Termination Messages 
No. Type Message Description Remedial Measures 

0592 Terminated 
Fatal Error (This 
application will be 
terminated.) 

The software will be aborted 
because a fatal error has been 
detected. 

- Refer to the remedial 
measures for the error 
message displayed before 
this message. 
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Appendix B. Version Compatibility 
We recommend using the latest version for the DTAP200 software, as well as the 
firmware on the connected DTSX200, as there may be functional limitations 
otherwise. 
Beware also of possible functional limitations when loading a setting file that is 
saved using a different software version. 
 

Appendix B.1 Version Compatibility Tables 
● Version compatibility between DTAP200 software and DTSX200 

firmware 
The DTAP200 software compares its own version against the version of the firmware 
installed on a connected DTSX200 and performs version compatibility processing 
accordingly. 

DTAP200 
software version 

DTSX200 
firmware version Limitations 

R1.02.01 R1.02.01 This combination is recommended. (No limitation exists.) 
R1.01.01 R1.02.01 Functional limitations exist on the DTAP200 software side. 

R1.02.01 R1.01.01 
Functional limitations exist on the DTSX200 firmware side. 
The Calculation Range setting on the Fiber Setting tab of channel 
settings is not displayed in the DTAP200 software, and 
measurement result is output using all data. 

   
   
   
   
   
   
 

● Limitations when loading a setting file saved using a different software 
version 

Version of 
DTAP200 used to 

load settings 

Version of 
DTAP200 used to 

save settings 
Limitations 

R1.01.01 R1.02.01 Calculation Range settings newly added in version R1.02.01 are 
ignored. 

R1.02.01 R1.01.01 The Calculation Range setting on the Fiber Setting tab of channel 
settings defaults to All Data. 
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